Schematic Editor

The KiCad Team
## Table of Contents

**Introduction to the KiCad Schematic Editor** ................................................................. 2

  - Description .................................................................................................................. 2

**Initial Configuration** .................................................................................................. 2

**The Schematic Editor User Interface** ......................................................................... 4

  - Navigating the editing canvas .................................................................................... 4

**Hotkeys** ....................................................................................................................... 5

**Mouse operations and selection** .................................................................................. 5

**Left toolbar display controls** ...................................................................................... 6

**Schematic Creation and Editing** .................................................................................. 7

  - Introduction ................................................................................................................ 7

**Schematic editing operations** ....................................................................................... 7

**Grids** .......................................................................................................................... 9

**Snapping** .................................................................................................................... 9

**Working with symbols** ................................................................................................ 9

**Reference Designators and Symbol Annotation** ......................................................... 15

**Electrical Connections** ............................................................................................... 17

**Graphical items** ........................................................................................................... 26

**Schematic Setup** ......................................................................................................... 28

**Rescuing cached symbols** .......................................................................................... 28

**Hierarchical schematics** ............................................................................................. 30

  - Introduction ................................................................................................................ 30

**Adding sheets to a design** ............................................................................................ 30

**Navigating between sheets** ........................................................................................ 32

**Electrical connections between sheets** ...................................................................... 32

**Hierarchical design examples** ..................................................................................... 34

**Inspecting a schematic** ............................................................................................... 37

  - Find tool ...................................................................................................................... 37

**Net highlighting** ........................................................................................................... 38

**Cross-probing from the PCB** ...................................................................................... 38

**Design verification with Electrical Rules Check** ......................................................... 38

**Assigning Footprints** .................................................................................................. 44

  - Assigning Footprints in Symbol Properties ............................................................... 44

  - Assigning Footprints While Placing Symbols ........................................................... 46

  - Assigning Footprints with the Footprint Assignment Tool ...................................... 47

**Transferring designs between schematic and PCB** .................................................... 56

  - Update PCB from Schematic .................................................................................... 56

  - Update Schematic from PCB .................................................................................... 57

**Generating Outputs** .................................................................................................... 58

  - Printing ...................................................................................................................... 58

  - Plotting ...................................................................................................................... 58

  - Generating a Bill of Materials ................................................................................... 60

**Netlists** ....................................................................................................................... 62
Managing Symbol Libraries ................................................................. 67
Symbol Library Table .......................................................................... 67
Symbol Editor ...................................................................................... 71
  General Information About Symbol Libraries .................................. 71
  Symbol Library Overview ................................................................. 71
  Symbol Library Editor Overview ....................................................... 71
  Library Selection and Maintenance .................................................. 75
  Creating Library Symbols ................................................................ 75
  Graphical Elements ........................................................................... 82
  Multiple Units per Symbol and Alternate Body Styles ....................... 84
  Pin Creation and Editing ................................................................... 87
  Symbol Fields .................................................................................... 94
  Creating Power Port Symbols ............................................................ 95
Symbol Library Browser ....................................................................... 99
  Introduction ...................................................................................... 99
  Viewlib - main screen ..................................................................... 100
  Symbol Library Browser Top Toolbar .............................................. 100
Simulator .......................................................................................... 102
  Assigning models .......................................................................... 102
  Spice directives ............................................................................... 107
  Simulation ......................................................................................... 107
Advanced Topics .................................................................................. 114
  Configuration and Customization .................................................... 114
  Text variables ................................................................................ 114
  Custom Netlist and BOM Formats .................................................... 114
Actions reference ............................................................................... 130
  Schematic Editor .......................................................................... 130
  Common ......................................................................................... 135
This manual is in the process of being revised to cover the latest stable release version of KiCad. It contains some sections that have not yet been completed. We ask for your patience while our volunteer technical writers work on this task, and we welcome new contributors who would like to help make KiCad's documentation better than ever.

Copyright

This document is Copyright © 2010-2022 by its contributors as listed below. You may distribute it and/or modify it under the terms of either the GNU General Public License (http://www.gnu.org/licenses/gpl.html), version 3 or later, or the Creative Commons Attribution License (http://creativecommons.org/licenses/by/3.0/), version 3.0 or later.

All trademarks within this guide belong to their legitimate owners.

Contributors

Jean-Pierre Charras, Fabrizio Tappero, Wayne Stambaugh, Graham Keeth

Feedback

The KiCad project welcomes feedback, bug reports, and suggestions related to the software or its documentation. For more information on how to submit feedback or report an issue, please see the instructions at https://www.kicad.org/help/report-an-issue/
Introduction to the KiCad Schematic Editor

Description
The KiCad Schematic Editor is a schematic capture software distributed as a part of KiCad and available under the following operating systems:

- Linux
- Apple macOS
- Windows

Regardless of the OS, all KiCad files are 100% compatible from one OS to another.

The Schematic Editor is an integrated application where all functions of drawing, control, layout, library management and access to the PCB design software are carried out within the editor itself.

The KiCad Schematic Editor is intended to cooperate with the KiCad PCB Editor, which is KiCad's printed circuit design software. It can also export netlist files, which lists all the electrical connections, for other packages.

The Schematic Editor includes a symbol library editor, which can create and edit symbols and manage libraries. It also integrates the following additional but essential functions needed for modern schematic capture software:

- Electrical rules check (ERC) for the automatic control of incorrect and missing connections
- Export of plot files in many formats (Postscript, PDF, HPGL, and SVG)
- Bill of Materials generation (via Python or XSLT scripts, which allow many flexible formats).

The Schematic Editor supports multi-sheet schematics in several ways:

- Flat hierarchies (schematic sheets are not explicitly connected in a master diagram).
- Simple hierarchies (each schematic sheet is used only once).
- Complex hierarchies (some schematic sheets are used multiple times).

Hierarchical schematics are described in detail later in the manual.

Initial Configuration
When the Schematic Editor is run for the first time, if the the global symbol library table file sym-lib-table is not found in the KiCad configuration folder then KiCad will ask how to create this file:
The first option is recommended (Copy default global symbol library table (recommended)). The default symbol library table includes all of the standard symbol libraries that are installed as part of KiCad.

If this option is disabled, KiCad was unable to find the default global symbol library table. This probably means you did not install the standard symbol libraries with KiCad, or they are not installed where KiCad expects to find them. On some systems the KiCad libraries are installed as a separate package.

- If you have installed the standard KiCad symbol libraries and want to use them, but the first option is disabled, select the second option and browse to the `sym-lib-table` file in the directory where the KiCad libraries were installed.
- If you already have a custom symbol library table that you would like to use, select the second option and browse to your `sym-lib-table` file.
- If you want to construct a new symbol library table from scratch, select the third option.

Symbol library management is described in more detail later.
The main Schematic Editor user interface is shown above. The center contains the main editing canvas, which is surrounded by:

- Top toolbars (file management, zoom tools, editing tools)
- Left toolbar (display options)
- Message panel and status bar at bottom
- Right panel (drawing and design tools)

**Navigating the editing canvas**

The editing canvas displays the schematic being designed. You can pan and zoom to different parts of the schematic and open any schematic sheet in the design.

By default, dragging with the middle or right mouse button will pan the canvas view and scrolling the mouse wheel will zoom the view in or out. You can change this behavior in the Mouse and Touchpad section of the preferences (see [Configuration and Customization](#) for details).

Several other zoom tools are available in the top toolbar:

- + zooms in on the center of the viewport.
• zooms out from the center of the viewport.
• zooms to fit the frame around the drawing sheet.
• zooms to fit the items within the drawing sheet.
• allows you to draw a box to determine the zoomed area.

The cursor's current position is displayed at the bottom of the window (X and Y), along with the current zoom factor (Z), the cursor's relative position (dx, dy, and dist), the grid setting, and the display units.

The relative coordinates can be reset to zero by pressing `Space`. This is useful for measuring distance between two points or aligning objects.

### Hotkeys

The `Ctrl + F1` shortcut displays the current hotkey list. The default hotkey list is included in the Actions Reference section of the manual.

The hotkeys described in this manual use the key labels that appear on a standard PC keyboard. On an Apple keyboard layout, use the `Cmd` key in place of `Ctrl`, and the `Option` key in place of `Alt`.

Many actions do not have hotkeys assigned by default, but hotkeys can be assigned or redefined using the hotkey editor (`Preferences` → `Preferences...` → `Hotkeys`).

**NOTE**

Many of the actions available through hotkeys are also available in context menus. To access the context menu, right-click in the editing canvas. Different actions will be available depending on what is selected or what tool is active.

Hotkeys are stored in the file `user.hotkeys` in KiCad's configuration directory. The location is platform-specific:

- Windows: `%APPDATA%\kicad\6.0\user.hotkeys`
- Linux: `~/.config/kicad/6.0/user.hotkeys`
- macOS: `~/Library/Preferences/kicad/6.0/user.hotkeys`

KiCad can import hotkey settings from a `user.hotkeys` file using the `Import Hotkeys` button in the hotkey editor.

### Mouse operations and selection

Selecting items in the editing canvas is done with the left mouse button. Single-clicking on an object will select it and dragging will perform a box selection. A box selection from left to right will only select items that are fully inside the box. A box selection from right to left will select any items that touch the box. A left-to-right selection box is drawn in yellow, with a cursor that indicates exclusive selection, and a right-to-left selection box is drawn in blue with a cursor that indicates inclusive selection.

The selection action can be modified by holding modifier keys while clicking or dragging. The following modifier keys apply when clicking to select single items:
Modifier Keys (Windows)  Modifier Keys (Linux)  Modifier Keys (macOS)  Selection Effect

<table>
<thead>
<tr>
<th>Modifier Keys</th>
<th>Modifier Keys</th>
<th>Modifier Keys</th>
<th>Selection Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td>Shift</td>
<td>Shift</td>
<td>Add the item to the existing selection.</td>
</tr>
<tr>
<td>Ctrl + Shift</td>
<td>Ctrl + Shift</td>
<td>Cnd + Shift</td>
<td>Remove the item from the existing selection.</td>
</tr>
<tr>
<td>long click</td>
<td>long click</td>
<td>long click or</td>
<td>Clarify selection from a pop-up menu.</td>
</tr>
<tr>
<td>long click or</td>
<td>long click or</td>
<td>Option</td>
<td>Highlight the net of the selected copper item.</td>
</tr>
<tr>
<td>Alt</td>
<td>Option</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ctrl</td>
<td>Ctrl</td>
<td>Cnd</td>
<td></td>
</tr>
</tbody>
</table>

The following modifier keys apply when dragging to perform a box selection:

Modifier Keys (Windows)  Modifier Keys (Linux)  Modifier Keys (macOS)  Selection Effect

<table>
<thead>
<tr>
<th>Modifier Keys</th>
<th>Modifier Keys</th>
<th>Modifier Keys</th>
<th>Selection Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift or Ctrl</td>
<td>Shift or Ctrl</td>
<td>Shift or Ctrl</td>
<td>Add item(s) to the existing selection.</td>
</tr>
<tr>
<td>Ctrl + Shift</td>
<td>Ctrl + Shift</td>
<td>Cnd + Shift</td>
<td>Remove item(s) from the existing selection.</td>
</tr>
</tbody>
</table>

Selecting an object displays information about the object in the message panel at the bottom of the window. Double-clicking an object opens a window to edit the object’s properties.

Pressing \[Esc\] will always cancel the current tool or operation and return to the selection tool. Pressing \[Esc\] while the selection tool is active will clear the current selection.

**Left toolbar display controls**

The left toolbar provides options to change the display of items in the Schematic Editor.

- **Grid display control**: Turns grid display on/off.
  
  *Note*: by default, hiding the grid will disable grid snapping. This behavior can be changed in the Display Options section of Preferences.

- **Display/entry of coordinates and dimensions**: Display or entry of coordinates and dimensions in inches, mils, or millimeters.

- **Screen and cursor control**: Switches between full-screen and small editing cursor (crosshairs).

- **Invisible pin display control**: Turns invisible pin display on/off.

- **Placement line control**: Switches between free angle and horizontal/vertical placement of new wires, buses, and graphical lines.
Schematic Creation and Editing

Introduction

A schematic designed with KiCad is more than a simple graphic representation of an electronic device. It is normally the entry point of a development chain that allows for:

- Validating against a set of rules (Electrical Rules Check) to detect errors and omissions.
- Automatically generating a bill of materials.
- Generating a netlist for simulation software such as SPICE.
- Defining a circuit for transferring to PCB layout.

A schematic mainly consists of symbols, wires, labels, junctions, buses and power ports. For clarity in the schematic, you can place purely graphical elements like bus entries, comments, and polylines.

Symbols are added to the schematic from symbol libraries. After the schematic is made, the set of connections and footprints is imported into the PCB editor for designing a board.

Schematics can be contained in a single sheet or split among multiple sheets. In KiCad, multi-sheet schematics are organized hierarchically, with a root sheet and sub-sheet(s). Each sheet is its own .kicad_sch file and is itself a complete KiCad schematic. Working with hierarchical schematics is described in the Hierarchical Schematics chapter.

Schematic editing operations

Schematic editing tools are located in the right toolbar. When a tool is activated, it stays active until a different tool is selected or the tool is canceled with the Esc key. The selection tool is always activated when any other tool is canceled.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Selection tool" /></td>
<td>Selection tool (the default tool)</td>
</tr>
<tr>
<td><img src="image" alt="Highlight a net" /></td>
<td>Highlight a net by marking its wires and net labels with a different color. If the PCB Editor is also open then copper corresponding to the selected net will be highlighted as well. Net highlighting can be cleared by clicking with the highlight tool in an empty space, or by using the Clear Net Highlighting hotkey (Esc).</td>
</tr>
<tr>
<td><img src="image" alt="Display symbol selector" /></td>
<td>Display the symbol selector dialog to place a new symbol.</td>
</tr>
<tr>
<td><img src="image" alt="Display power symbol selector" /></td>
<td>Display the power symbol selector dialog to place a new power symbol.</td>
</tr>
<tr>
<td><img src="image" alt="Draw wire" /></td>
<td>Draw a wire.</td>
</tr>
<tr>
<td><img src="image" alt="Draw bus" /></td>
<td>Draw a bus.</td>
</tr>
<tr>
<td><img src="image" alt="Draw wire-to-bus entry points" /></td>
<td>Draw wire-to-bus entry points. These elements are only graphical and do not create a connection, thus they should not be used to connect wires together.</td>
</tr>
<tr>
<td><img src="image" alt="Place no connect flag" /></td>
<td>Place a &quot;No Connect&quot; flag. These flags should be placed on symbol pins which are meant to be left unconnected. &quot;No connect&quot; flags indicate to the Electrical Rule Checker that the pin is intentionally unconnected and not an error.</td>
</tr>
<tr>
<td><img src="image" alt="Place junction" /></td>
<td>Place a junction. This connects two crossing wires or a wire and a pin, which can sometimes be ambiguous without a junction (i.e. if a wire end or a pin is not directly connected to another wire end).</td>
</tr>
<tr>
<td><img src="image" alt="Place local label" /></td>
<td>Place a local label. Local labels connect items located in the same sheet. For connections between two different sheets, use global or hierarchical labels.</td>
</tr>
<tr>
<td><img src="image" alt="Place global label" /></td>
<td>Place a global label. All global labels with the same name are connected, even when located on different sheets.</td>
</tr>
<tr>
<td><img src="image" alt="Place hierarchical label" /></td>
<td>Place a hierarchical label. Hierarchical labels are used to create a connection between a subsheet and the sheet's parent sheet. See the Hierarchical Schematics section for more information about hierarchical labels, sheets, and pins.</td>
</tr>
<tr>
<td><img src="image" alt="Place hierarchical subsheet" /></td>
<td>Place a hierarchical subsheet. You must specify the file name for this subsheet.</td>
</tr>
<tr>
<td><img src="image" alt="Import hierarchical pin" /></td>
<td>Import a hierarchical pin from a subsheet. This command can be executed only on hierarchical subsheets. It will create hierarchical pins corresponding to hierarchical labels placed in the target subsheet.</td>
</tr>
<tr>
<td><img src="image" alt="Draw lines" /></td>
<td>Draw lines. <strong>Note:</strong> Lines are graphical objects and are not the same as wires placed with the Wire tool. They do not connect anything.</td>
</tr>
<tr>
<td><img src="image" alt="Place text comment" /></td>
<td>Place a text comment.</td>
</tr>
<tr>
<td><img src="image" alt="Place bitmap image" /></td>
<td>Place a bitmap image.</td>
</tr>
<tr>
<td><img src="image" alt="Delete clicked items" /></td>
<td>Delete clicked items.</td>
</tr>
</tbody>
</table>
Grids

In the Schematic Editor the cursor always moves over a grid. The grid can be customized:

- Size can be changed using the right click menu or using View → Grid Properties.
- Color can be changed in the Colors page of the Preferences dialog (menu Preferences → General Options).
- Visibility can be switched using the left-hand toolbar button.

The default grid size is 50 mil (0.050") or 1.27 millimeters.

This is the recommended grid for placing symbols and wires in a schematic, and for placing pins when designing a symbol in the Symbol Editor.

NOTE

Wires connect with other wires or pins only if their ends coincide exactly. Therefore it is very important to keep symbol pins and wires aligned to the grid. It is recommended to always use a 50 mil grid when placing symbols and drawing wires because the KiCad standard symbol library and all libraries that follow its style also use a 50 mil grid. Using a grid size other than 50 mil will result in schematics without proper connectivity!

Smaller grids can also be used, but this is intended only for text and symbol graphics, and not recommended for placing pins and wires.

NOTE

Symbols, wires, and other elements that are not aligned to the grid can be snapped back to the grid by selecting them, right clicking, and clicking Align Elements to Grid.

Snapping

Schematic elements such as symbols, wires, text, and graphic lines are snapped to the grid when moving, dragging, and drawing them. Additionally, the wire tool snaps to pins even when grid snapping is disabled. Both grid and pin snapping can be disabled while moving the mouse by using the modifier keys in the table below.

NOTE

On Apple keyboards, use the Command key instead of Ctrl.

<table>
<thead>
<tr>
<th>Modifier Key</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl</td>
<td>Disable grid snapping.</td>
</tr>
<tr>
<td>Shift</td>
<td>Disable snapping wires to pins.</td>
</tr>
</tbody>
</table>

Working with symbols

Placing symbols

To load a symbol into your schematic you can use the icon A. A dialog box allows you to type the name of the symbol to load.
The Choose Symbols dialog will filter symbols by name, keywords, and description according to what you type into the search field.

Some advanced filters are available:

- **Wildcards**: use the characters `?` and `*` respectively to mean "any single character or no characters" and "any number of any characters, including none".

- **Key-value pairs**: if a library part’s description or keywords contain a tag of the format "Key:123", you can match relative to that by typing "Key>123" (greater than), "Key<123" (less than), etc. Numbers may include one of the following case-insensitive suffixes:

<table>
<thead>
<tr>
<th>p</th>
<th>n</th>
<th>u</th>
<th>m</th>
<th>k</th>
<th>meg</th>
<th>g</th>
<th>t</th>
</tr>
</thead>
<tbody>
<tr>
<td>10^{-12}</td>
<td>10^{-9}</td>
<td>10^{-6}</td>
<td>10^{-3}</td>
<td>10^{3}</td>
<td>10^{6}</td>
<td>10^{9}</td>
<td>10^{12}</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ki</th>
<th>mi</th>
<th>gi</th>
<th>ti</th>
</tr>
</thead>
<tbody>
<tr>
<td>2^{10}</td>
<td>2^{20}</td>
<td>2^{30}</td>
<td>2^{40}</td>
</tr>
</tbody>
</table>

- **Regular expressions**: if you’re familiar with regular expressions, these can be used too. The regular expression flavor used is the **wxWidgets Advanced Regular Expression style**, which is similar to Perl regular expressions.
If the symbol specifies a default footprint, this footprint will be previewed in the lower right. If the symbol includes footprint filters, alternate footprints that satisfy the footprint filters can be selected in the footprint dropdown menu at right.

After selecting a symbol to place, the symbol will be attached to the cursor. Left clicking the desired location in the schematic places the symbol into the schematic. Before placing the symbol in the schematic, you can rotate it, mirror it, and edit its fields, by either using the hotkeys or the right-click context menu. These actions can also be performed after placement.

Here is a symbol during placement:

If the **Place repeated copies** option is checked, after placing a symbol KiCad will start placing another copy of the symbol. This process continues until the user presses `Esc`.

For symbols with multiple units, if the **Place all units** option is checked, after placing the symbol KiCad will start placing the next unit in the symbol. This continues until the last unit has been placed or the user presses `Esc`.

**Placing power ports**

A **power port symbol** is a symbol representing a connection to a power net. The symbols are grouped in the `power` library, so they can be placed using the symbol chooser. However, as power placements are frequent, the `power` tool is available. This tool is similar, except that the search is done directly in the `power` library and any other library that contains power symbols.
Moving symbols
Symbols can be moved using the Move (\text{M}) or Drag (\text{G}) tools. These tools act on the selected symbol, or if no symbol is selected they act on the symbol under the cursor.

The \text{Move} tool moves the symbol itself without maintaining wired connections to the symbol pins.

The \text{Drag} tool moves the symbol without breaking wired connections to its pins, and therefore moves the connected wires as well.

You can also Drag symbols by clicking and dragging them with the mouse, depending on the Left button drag gesture setting in the Mouse and Touchpad section of Preferences.

Symbols can also be rotated (\text{R}) or mirrored in the X (\text{X}) or Y (\text{Y}) directions.

Editing symbol properties
A symbol's fields can be edited in the symbol's Properties window. Open the Symbol Properties window for a symbol with the \text{E} hotkey or by double-clicking on the symbol.

The Symbol Properties window displays all the fields of a symbol in a table. New fields can be added, and existing fields can be deleted, edited, reordered, moved, or resized.

Each field can be visible or hidden, and displayed horizontally or vertically. The displayed position is always indicated for a normally displayed symbol (no rotation or mirroring) and is relative to the anchor point of the symbol.

The position and orientation properties of each field may be hidden in this dialog. They can be shown by right-clicking on the column header of the fields table and enabling the "Orientation", "X Position", and/or "Y
Position" columns. Other columns can be shown or hidden as desired.

The "Update Symbol from Library..." button is used to update the schematic's copy of the symbol to match the copy in the library. The "Change Symbol..." button is used to swap the current symbol to a different symbol in the library.

"Edit Symbol..." opens the Symbol Editor to edit the copy of the symbol in the schematic. Note that the original symbol in the library will not be modified. The "Edit Library Symbol..." button opens the Symbol Editor to edit the original symbol in the library. In this case, the symbol in the schematic will not be modified until the user clicks the "Update Symbol from Library..." button.

**Editing symbol fields individually**

An individual symbol text field can be edited directly with the **E** hotkey (with a field selected instead of a symbol) or by double-clicking on the field.

Some symbol fields have their own hotkey to edit them directly. With the symbol selected, the Reference, Value, and Footprint fields can be edited with the **U**, **V**, or **F** hotkeys, respectively.

![Edit Value Field dialog](image)

The options in this dialog are the same as those in the full Symbol Properties dialog, but are specific to a single field.

Symbol fields can be automatically moved to an appropriate location with the Autoplace Fields action (select a symbol and press **O**). Field autoplacement is configurable in the Schematic Editor's Editing Options, including a setting to always autoplace fields.

**Symbol Fields Table**

The Symbol Fields Table allows you to view and modify field values for all symbols in a spreadsheet interface. You can open the Symbol Fields Table with the **Symbols Table** button.
Cells are navigated with the arrow keys, or with Tab / Shift + Tab to move right / left and Enter to move down / up, respectively.

A range of cells can be selected by clicking and dragging. The whole range of selected cells will be copied (Ctrl+C) or pasted into (Ctrl+V) on a copy or paste action. Copying a range of cells from the table can be useful for creating a BOM. More details of copying and pasting cells are described below.

Any symbol field can be shown or hidden using the Show checkboxes on the left, or by right-clicking on the header of the table. New symbol fields can be added using the Add Field... button.

Similar symbols can optionally be grouped by any symbol field using the Group By checkboxes. Grouped symbols are shown in a single row in the table. The grouped row can be expanded to show the individual symbols by clicking the arrow at the left of the row.

**Tricks to simplify filling fields**

There are several special copy/paste methods in the spreadsheet for pasting values into larger regions, including auto-incrementing pasted cells. These features may be useful when pasting values that are shared in several symbols.
These methods are illustrated below.

<table>
<thead>
<tr>
<th>1. Copy (ctrl + C)</th>
<th>2. Select target cells</th>
<th>3. Paste (ctrl + V)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td><img src="image8.png" alt="Image" /></td>
<td><img src="image9.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="image10.png" alt="Image" /></td>
<td><img src="image11.png" alt="Image" /></td>
<td><img src="image12.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="image13.png" alt="Image" /></td>
<td><img src="image14.png" alt="Image" /></td>
<td><img src="image15.png" alt="Image" /></td>
</tr>
</tbody>
</table>

**NOTE** These techniques are also available in other dialogs with a grid control element.

**Reference Designators and Symbol Annotation**

Reference designators are unique identifiers for components in a design. They are often printed on a PCB and in assembly diagrams, and allow you to match symbols in a schematic to the corresponding components on a board.
In KiCad, reference designators consist of a letter indicating the type of component (R for resistor, C for capacitor, U for IC, etc) followed by a number. If the symbol has multiple units then the reference designator will also have a trailing letter indicating the unit. Symbols that don’t have a reference designator set have a ? character instead of the number. Reference designators must be unique.

Reference designators can set manually by editing a symbol’s reference designator field, or automatically using the Annotation tool.

**NOTE** The process of setting a symbol’s reference designator is called annotation.

**Annotation tool**

The Annotation tool automatically assigns reference designators to symbols in the schematic. To launch the Annotation tool, click the button in the top toolbar.

The tool provides several options to control how symbols are annotated.

**Scope**: Selects whether annotation is applied to the entire schematic, to only the current sheet, or to only the selected symbols.

**Options**: Selects whether annotation should apply to all symbols and reset *existing reference designators, or apply only to unannotated symbols.

**Order**: Chooses the direction of numbering. If symbols are sorted by X position, all symbols on the left side of a schematic sheet will be lower numbered than symbols on the right side of the sheet. If symbols are sorted by Y position, all symbols on the top of a sheet will be lower numbered than symbols at the bottom of the sheet.
**Numbering:** Selects the starting point for numbering reference designators. The lowest unused number above the starting point is picked for each reference designator. The starting point can be an arbitrary number (typically zero), or it can be the sheet number multiplied by 100 or 1000 so that each part’s reference designator corresponds to the schematic page it is on.

The **Clear Annotation** button clears all reference designators in the selected scope.

Annotation messages can be filtered with the checkboxes at the bottom or saved to a report using the **Save...** button.

**Electrical Connections**

There are two primary ways to establish connections: wires and labels. Both are shown in the schematic below.

Connections can also be made with buses and with implicit connections via hidden power pins.

This section will also discuss two special types of symbols that can be added with the "Power port" button on the right toolbar:

- **Power ports:** symbols for connecting wires to a power or ground net.
- **PWR_FLAG:** a specific symbol for indicating that a net is powered when it is not connected to a power output pin (for example, a power net that is supplied by an off-board connector).

**Label Connections**

Labels are used to assign net names to wires and pins. Wires with the same net name are considered to be connected. A net can only have one name. If two different labels are placed on the same net, an ERC violation
will be generated. Only one of the net names will be used in the netlist. The final net name is determined according to the rules described below.

There are three types of labels, each with a different connection scope.

- **Local labels**, also referred to simply as labels, only make connections within a sheet. Add a local label with the \[\text{A}\] button in the right toolbar.

- **Global labels** make connections anywhere in a schematic, regardless of sheet. Add a global label with the \[\text{A\textarrow}\] button in the right toolbar.

- **Hierarchical labels** connect to hierarchical sheet pins and are used in hierarchical schematics for connecting child sheets to their parent sheet. Add a hierarchical label with the \[\text{A\textdiamond}\] button in the right toolbar.

NOTE Labels that have the same name will connect, regardless of the label type, if they are in the same sheet.

After using the appropriate button or hotkey to create a label, the Label Properties dialog appears.

![Global Label Properties dialog](image)

The **Label** field sets the label's text, which determines the net that the label assigns to its attached wire. Label text supports markup for overbars, subscripts, etc., as well as variable substitution. Use the Syntax help link in the dialog for a summary.

**Justification** sets the position of the label's connection point relative to the label's text. For example, when **Align right** is selected the connection point will be to the right of the text.

**Text size** and **Style** control the appearance of the label's text. **Shape** controls the shape of the outline around the label; this is purely visual and has no electrical consequence. Local labels do not have an outline, and therefore do not have **Shape** options.
Global labels have additional settings to control margins around the label text in the Schematic Setup dialog.

After accepting the label properties, the label is attached to the cursor for placement. The connection point for a label is the small square in the corner of the label. The square disappears when the label is connected to a wire or the end of a pin.

The connection point's position relative to the label text can be changed by choosing a different label orientation in the label's properties, or by mirroring/rotating the label.

The Label Properties dialog can be accessed at any time by selecting a label and using the hotkey, double-clicking on the label, or with Properties... in the right-click context menu.

**Wire Connections**

To establish a connection, a segment of wire must be connected by its end to another segment or to a pin. Only wire ends create connections; if a wire crosses the middle of another wire, a connection will not be made.

Unconnected wire ends have a small square that indicates the connection point. The square disappears when a connection is made to the wire end. Unconnected pins have a circle, which also disappears when a connection is made.

**NOTE**

Wires connect with other wires or pins only if their ends coincide exactly. Therefore it is important to keep symbol pins and wires aligned to the grid. It is recommended to always use a 50 mil grid when placing symbols and drawing wires because the KiCad standard symbol library and all libraries that follow its style also use a 50 mil grid.

**NOTE**

Symbols, wires, and other elements that are not aligned to the grid can be snapped back to the grid by selecting them, right clicking, and selecting Align Elements to Grid.

**Drawing and editing wires**

To begin connecting elements with wire, use the Wire tool in the right toolbar ( ). Wires can also be automatically started by clicking on an unconnected symbol pin or wire end.

Wires can be moved using the Move ( ) or Drag ( ) tools. As with symbols, the Move tool moves only the selected segment, without maintaining existing connections to other segments. The Drag tool maintains existing connections.

If a segment is selected or the cursor is over the middle of a wire, the move/drag action will move the entire segment. If the cursor is over a corner or wire end, the move/drag action will act on one end of the segment.
Wire Junctions

Wires that cross are not implicitly connected. It is necessary to join them by explicitly adding a junction dot if a connection is desired (button in the right toolbar). Junction dots will be automatically added to wires that start or end on top of an existing wire.

Junction dots are used in the schematic figure above on the wires connected to P1 pins 18, 19, 20, 21, 22, and 23.

Bus Connections

Buses are a way to group related signals in the schematic in order to simplify complicated designs. Buses can be drawn like wires using the bus tool, and are named using labels the same way signal wires are.

In the following schematic, many pins are connected to buses, which are the thick blue lines in the center.

Bus members

There are two types of bus in KiCad 6.0 and later: vector buses and group buses.

A vector bus is a collection of signals that start with a common prefix and end with a number. Vector buses are named &lt;PREFIX&gt;[M .. N] where PREFIX is any valid signal name, M is the first suffix number, and N is
the last suffix number. For example, the bus \texttt{DATA[0..7]} contains the signals \texttt{DATA0}, \texttt{DATA1}, and so on up to \texttt{DATA7}. It doesn't matter which order \texttt{M} and \texttt{N} are specified in, but both must be non-negative.

A \textbf{group bus} is a collection of one or more signals and/or vector buses. Group buses can be used to bundle together related signals even when they have different names. Group buses use a special label syntax:

\begin{verbatim}
<OPTIONAL_NAME>{SIGNAL1 SIGNAL2 SIGNAL3}
\end{verbatim}

The members of the group are listed inside curly braces ( \{\} ) separated by space characters. An optional name for the group goes before the opening curly brace. If the group bus is unnamed, the resulting nets on the PCB will just be the signal names inside the group. If the group bus has a name, the resulting nets will have the name as a prefix, with a period (.) separating the prefix from the signal name.

For example, the bus \{SCL SDA\} has two signal members, and in the netlist these signals will be \texttt{SCL} and \texttt{SDA}. The bus \texttt{USB1\{DP DM\}} will generate nets called \texttt{USB1.DP} and \texttt{USB1.DM}. For designs with larger buses that are repeated across several similar circuits, using this technique can save time.

Group buses can also contain vector buses. For example, the bus \texttt{MEMORY\{A[7..0] D[7..0] OE WE\}} contains both vector buses and plain signals, and will result in nets such as \texttt{MEMORY.A7} and \texttt{MEMORY.OE} on the PCB.

Bus wires can be drawn and connected in the same manner as signal wires, including using junctions to create connections between crossing wires. Like signals, buses cannot have more than one name — if two conflicting labels are attached to the same bus, an ERC violation will be generated.

\section*{Connections between bus members}

Pins connected between the same members of a bus must be connected by labels. It is not possible to connect a pin directly to a bus; this type of connection will be ignored by KiCad.

In the example above, connections are made by the labels placed on wires connected to the pins. Bus entries (wire segments at 45 degrees) to buses are graphical only, and are not necessary to form logical connections.

In fact, using the repetition command ( \texttt{Insert} ), connections can be very quickly made in the following way, if component pins are aligned in increasing order (a common case in practice on components such as memories, microprocessors...):

\begin{itemize}
  \item Place the first label (for example \texttt{PCA0})
  \item Use the repetition command as much as needed to place members. KiCad will automatically create the next labels ( \texttt{PCA1}, \texttt{PCA2} ...) vertically aligned, theoretically on the position of the other pins.
  \item Draw the wire under the first label. Then use the repetition command to place the other wires under the labels.
  \item If needed, place the bus entries by the same way (Place the first entry, then use the repetition command).
\end{itemize}

\begin{tabular}{|l|}
\hline
\textbf{NOTE} & In the \textbf{Schematic Editor} \rightarrow \textbf{Editing Options} section of the Preferences menu, you can set the repetition parameters:
\hline
\end{tabular}

\begin{itemize}
  \item Horizontal pitch
  \item Vertical pitch
  \item Label increment (labels can be incremented or decremented by 1, 2, 3, etc.)
\end{itemize}
**Bus unfolding**

The unfold tool allows you to quickly break out signals from a bus. To unfold a signal, right-click on a bus object (a bus wire, etc) and choose **Unfold from Bus**. Alternatively, use the **Unfold Bus** hotkey (default: Ctrl) when the cursor is over a bus object. The menu allows you to select which bus member to unfold.

After selecting the bus member, the next click will place the bus member label at the desired location. The tool automatically generates a bus entry and wire leading up to the label location. After placing the label, you can continue placing additional wire segments (for example, to connect to a component pin) and complete the wire in any of the normal ways.

**Bus aliases**

Bus aliases are shortcuts that allow you to work with large group buses more efficiently. They allow you to define a group bus and give it a short name that can then be used instead of the full group name across the schematic.

To create bus aliases, open the **Bus Definitions** dialog in the **Tools** menu.

![Bus Definitions dialog](image)

An alias may be named any valid signal name. Using the dialog, you can add signals or vector buses to the alias. As a shortcut, you can type or paste in a list of signals and/or buses separated by spaces, and they will all be added to the alias definition. In this example, we define an alias called **USB** with members **DP**, **DM**, and **VBUS**.
After defining an alias, it can be used in a group bus label by putting the alias name inside the curly braces of the group bus: `{USB}`. This has the same effect as labeling the bus `{DP DM VBUS}`. You can also add a prefix name to the group, such as USB1{USB}, which results in nets such as USB1.DP as described above. For complicated buses, using aliases can make the labels on your schematic much shorter. Keep in mind that the aliases are just a shortcut, and the name of the alias is not included in the netlist.

Bus aliases are saved in the schematic file. Any aliases created in a given schematic sheet are available to use in any other schematic sheet that is in the same hierarchical design.

**Buses with more than one label**

KiCad 5.0 and earlier allowed the connection of bus wires with different labels together, and would join the members of these buses during netlisting. This behavior has been removed in KiCad 6.0 because it is incompatible with group buses, and also leads to confusing netlists because the name that a given signal will receive is not easily predicted.

If you open a design that made use of this feature in a modern version of KiCad, you will see the Migrate Buses dialog which guides you through updating the schematic so that only one label exists on any given set of bus wires.

![Migrate Buses dialog](image)

For each set of bus wires that has more than one label, you must choose the label to keep. The drop-down name box lets you choose between the labels that exist in the design, or you can choose a different name by manually entering it into the new name field.

**Hidden Power Pins**

When the power pins of a symbol are visible, they must be connected, as with any other signal. However, symbols such as gates and flip-flops are sometimes drawn with hidden power input pins which are connected implicitly.

KiCad automatically connects invisible pins with type "power input" to a global net with the same name as the pin. For example, if a symbol has a hidden power input pin named VCC, this pin will be globally connected to the VCC net on all sheets.
Hidden pins can be shown in the schematic by checking the **Show hidden pins** option in the **Schematic Editor** → **Display Options** section of the preferences, or by selecting **View** → **Show hidden pins**. There is also a toggle icon on the left toolbar.

It may be necessary to join power nets of different names (for example, **GND** in TTL components and **VSS** in MOS components). To accomplish this, add a **power port symbol** for each net and connect them with a wire.

If hidden power pins are used, it is not recommended to use local labels for power connection, as they will not connect to hidden power pins on other sheets.

Care must be taken with hidden power input pins because they can create unintentional connections. By nature, hidden pins are invisible and do not display their pin name. This makes it easy to accidentally connect two power pins to the same net. For this reason, **using invisible power pins in symbols is not recommended** outside of power port symbols, and is only supported for compatibility with legacy designs and symbols.

### Power Ports

Power ports are symbols that are conventionally used to represent a connection to a power net, such as **VCC** or **GND**. In addition to being a visual indicator that the attached net is a power rail, power ports make global connections: two power ports with the same pin name connect to each other anywhere in the schematic, regardless of sheet.

In the figure below, power port symbols are used to connect the positive and negative terminals of the capacitors to the **VCC** and **GND** nets, respectively.

In the KiCad standard library, power ports are found in the **power** library, but power port symbols can be created in any library. To create a custom power port, make a new symbol with a power input pin that is set to be invisible. Name the pin according to the desired power net. In addition, set the "Define as power symbol" symbol property. As described in the **hidden power pins section**, invisible power input pins make
global connections based on the hidden power pin's name. The process of creating a power port is described in more detail in the Symbol Editor section.

NOTE

The connected net name is determined by the power port's pin name, not the name or value of the symbol. This means that power port net names can only be changed in the symbol editor, not in the schematic.

Net name assignment rules

Every net in the schematic is assigned a name, whether that name is specified by the user or automatically generated by KiCad.

When multiple labels are attached to the same net, the final net name is determined in the following order, from highest priority to lowest:

1. Global labels
2. Power ports
3. Local labels
4. Hierarchical labels
5. Hierarchical sheet pins

If there are multiple labels of one type attached to a net, the names are sorted alphabetically and the first is used.

If a net travels through multiple sheets in a hierarchy, and has no global label or power port, it will take its name from the highest level of the hierarchy where it has a hierarchical label or local label. As described above, local labels take priority over hierarchical labels.

If none of the labels above are attached to a net, the net's name is automatically generated based on the connected symbol pins.

PWR_FLAG

Two PWR_FLAG symbols are visible in the screenshot above. They indicate to ERC that the two power nets VCC and GND are actually connected to a power source, as there is no explicit power source such as a voltage regulator output attached to either net.

Without these two flags, the ERC tool would diagnose: Error: Input Power pin not driven by any Output Power pins.

The PWR_FLAG symbol is found in the power symbol library. The same effect can be achieved by connecting any power output pin to the net.

No-connection flag

No-connection flags (→ X ) are used to indicate that a pin is intentionally unconnected. These flags do not have any effect on the schematic's connectivity, but they prevent “unconnected pin” ERC warnings for pins that are intentionally unconnected.
Graphical items

Text and graphic lines

It can be useful to place annotations such as text fields and frames to aid in understanding the schematic. Text fields (T) and graphic lines (L) are intended for this use, as opposed to labels and wires, which are connection elements.

The image below shows graphic lines and text in addition to wires, local labels, and hierarchical labels.

Sheet title block

The title block is edited with the Page Settings tool ( ).
Each field in the title block can be edited, as well as the paper size and orientation. If the “Export to other sheets” option is checked for a field, that field will be updated in the title block of all sheets, rather than only the current sheet.

You can set the date to today’s or any other date by pressing the left arrow button by "Issue Date", but the date in the schematic will not be automatically updated.

A drawing sheet template file can also be selected.
The sheet number (Sheet X/Y) is automatically updated, but sheet page numbers can also be manually set using Edit → Edit Sheet Page Number.

**Schematic Setup**

The Schematic Setup window is used to set schematic options that are specific to the currently active schematic. For example, the Schematic Setup window contains formatting options, electrical rule configuration, netclass setup, and schematic text variable setup.

**Rescuing cached symbols**

By default, KiCad loads symbols from the project libraries according to the set paths and library order. This can cause a problem when loading a very old project: if the symbols in the library have changed or have been removed or the library no longer exists since they were used in the project, the ones in the project would be automatically replaced with the new versions. The new versions might not line up correctly or might be oriented differently leading to a broken schematic.

When a project is saved, a cache library with the contents of the current library symbols is saved along with the schematic. This allows the project to be distributed without the full libraries. If you load a project where symbols are present both in its cache and in the system libraries, KiCad will scan the libraries for conflicts. Any conflicts found will be listed in the following dialog:
You can see in this example that the project originally used a diode with the cathode facing up, but the library now contains one with the cathode facing down. This change would break the schematic! Pressing OK here will cause the symbol cache library to be saved into a special rescue library and all the symbols are renamed to avoid naming conflicts.

If you press Cancel, no rescues will be made, so KiCad will load all the new components by default. If you save the schematic at this point, your cache will be overwritten and the old symbols will not be recoverable. If you have saved the schematic, you can still go back and run the rescue function again by selecting "Rescue Cached Components" in the "Tools" menu to call up the rescue dialog again.

If you would prefer not to see this dialog, you can press "Never Show Again". The default will be to do nothing and allow the new components to be loaded. This option can be changed back in the Libraries preferences.
Hierarchical schematics

Introduction

In KiCad, multi-sheet schematics are hierarchical: there is a single root sheet, and additional sheets are created as subsheets of either the root sheet or another subsheet. Sheets can be included in a hierarchy multiple times, if desired.

Carefully drawing a schematic as a hierarchical design improves schematic legibility and reduces repetitive drawing.

Creating a hierarchical schematic starts from the root sheet. The process is to create a subsheet, then draw the circuit in the subsheet and make the necessary electrical connections between sheets. Connections can be made between nets in a subsheet and nets in the parent sheet using hierarchical pins and labels, or between any two nets in the hierarchy using global labels.

Adding sheets to a design

You can add a subsheet to a design with the Add Hierarchical Sheet tool (hotkey, or the button in the right toolbar). Launch the tool, then click twice in the canvas to draw the upper left and lower right corners of the subsheet symbol. Make the sheet outline large enough to fit the hierarchical pins you will add later.

The Sheet Properties dialog will appear and prompt you for a sheet name and filename.
The sheet name must be unique, as it is used in the full net name for any nets in the subsheet. For example, a net with the local label net1 in the sheet sheet1 would have a full net name of /sheet1/net1. The sheet name is also used to refer to the sheet in various places in the GUI, including the title block and the hierarchy navigator.

The sheet filename specifies the file that the new sheet will be saved to or loaded from. The path to the sheet file can be relative or absolute. It is usually preferable to save subsheet files in the project directory and use a relative path so that the project is portable.

A single sheet file can be used more than once in a project by specifying the same filename for each repeated sheet; the circuit drawn in the sheet will be instantiated once per usage, and any edits in once instance will be reflected in the other instances.

NOTE Sheet files can be shared between multiple projects to allow design reuse between projects. However, this is not recommended due to path portability concerns and the risk of unintentionally changing other projects while editing a shared sheet.

The sheet’s page number is configurable here. The page number is displayed in the sheet title block and the hierarchy navigator, and sheets are sorted by page number in the hierarchy navigator and when printing or plotting.

Several graphical options are also available. Border width sets the width of the border around the sheet shape. Border color and Background fill set the color for the border and fill of the sheet shape, respectively. If no color is set, a checkerboard swatch is shown and the default values from the color theme are used.

The Sheet Properties dialog can be accessed at any time by selecting a sheet symbol and using the hotkey, or by right-clicking on a sheet symbol and selecting Properties....
Navigating between sheets

You can enter a hierarchical sheet from the parent sheet by double-clicking the child sheet's shape, or right-clicking the child sheet and selecting **Enter Sheet**.

Return to the parent sheet by using the ↑ button in the top toolbar, or by right-clicking in an empty part of the schematic and clicking **Leave Sheet**.

Alternatively, you can jump to any sheet with the hierarchy navigator. To open the hierarchy navigator, click the button in the top toolbar. Each sheet in the design is displayed as an item in the tree. Clicking a sheet name opens that sheet in the editing canvas.

By default, the hierarchy navigator closes after a new sheet is opened. It can be configured to always remain open by selecting the **Keep hierarchy navigator open** option in the Editing Options section of the Schematic Editor preferences.

Electrical connections between sheets

**Label overview**

Electrical connections between sheets are made with labels. There are several kinds of labels in KiCad, each with a different connection scope.

- **Local labels** only make connections within a sheet. Therefore local labels cannot be used to connect between sheets. Local labels are added with the button.

- **Global labels** make connections anywhere in a schematic, regardless of sheet. Global labels are added with the button.

- **Hierarchical labels** connect to **hierarchical sheet pins** accessible in the parent sheet. Hierarchical designs rely on hierarchical labels and pins to make connections between parent sheets and child sheets; you can think of hierarchical pins as defining the interface for a sheet. Hierarchical labels are added with the button.

  **NOTE**  
  Labels that have the same name will connect, regardless of the label type, if they are in the same sheet.
NOTE  Hidden power pins can also be considered global labels, because they connect anywhere in the schematic hierarchy.

Hierarchical sheet pins

After placing hierarchical labels within the subsheet, matching hierarchical pins can be added to the subsheet symbol in the parent sheet. You can then make connections to the hierarchical pins with wires, labels, and buses. Hierarchical pins in a subsheet symbol are connected to the matching hierarchical labels in the subsheet itself.

NOTE  Hierarchical labels must be defined in the subsheet before the corresponding hierarchical sheet pin can be imported in the sheet symbol.

For every hierarchical label in the subsheet, import the corresponding hierarchical pin into the sheet symbol by clicking the button in the right toolbar, then clicking on the sheet symbol. A sheet pin for the first unmatched hierarchical label will be attached to the cursor, where it can be placed anywhere along the border of the sheet symbol. Clicking again with the tool will continue to import additional sheet pins until there are no more hierarchical pins to import from the subsheet. Sheet pins can also be imported by selecting Import Sheet Pin in a sheet symbol's right-click context menu.

You can edit the properties of a sheet pin in the Sheet Pin Properties dialog. Open this dialog by double-clicking a sheet pin, selecting a sheet pin and using the hotkey, or right-clicking a sheet pin and selecting Properties....
The sheet pin's **name** can be edited in the textbox or by selecting from the dropdown list of hierarchical labels in the subsheet. A sheet pin's name has to match the corresponding hierarchical label in the subsheet, so if a pin name is changed the label must change as well.

The **connection type** changes the shape of the sheet pin, and has no electrical effect. It can be set to Input, Output, Bidirectional, Tri-state, or Passive. The pin's **text size** can also be changed.

**Hierarchical design examples**

Hierarchical designs can be put into one of several categories:

- **Simple**: each sheet is used only once.
- **Complex**: some sheets are instantiated multiple times.
- **Flat**: a sub-case of a **simple** hierarchy, without connections between subsheets and their parent. Flat hierarchies can be used to represent a non-hierarchical design.

Each hierarchy model can be useful; the most appropriate one depends on the design.

**Simple hierarchy**

An example of a simple hierarchy is the video demo project included with KiCad. The root sheet contains seven unique subsheets, each with hierarchical labels and sheet pins linking the sheets to each other in the root sheet. Two of the subsheet symbols are shown below.
**Complex Hierarchy**

The complex_hierarchy demo project is an example of a complex hierarchy. The root sheet contains two subsheet symbols, which both refer to the same sheet file (ampli_ht.kicad_sch). This allows the design to include two copies of the same amplifier circuit. Although the two sheet symbols refer to the same filename, the sheet names are unique (ampli_ht_vertical and ampli_ht_horizontal). Inside each subsheet the circuits are identical except for the reference designators, which as always are unique.

This project contains no sheet pin connections. The only connections between the root sheet and the subsheets are global power connections made with power port symbols. However, sheets in a complex hierarchy could include sheet pin connections if appropriate for the design.
Flat hierarchy

The flat hierarchy demo project is an example of a flat hierarchy. The root sheet contains two unique subsheet symbols with no hierarchical sheet pins. The root sheet in this project does nothing except hold the subsheets, and the subsheets are used only as additional pages in the schematic.

**NOTE** This is the simplest way to create multi-page schematics in KiCad.
Inspecting a schematic

Find tool

The Find tool searches for text in the schematic, including reference designators, pin names, symbol fields, and graphic text. When the tool finds a match, the canvas is zoomed and centered on the match and the text is highlighted. Launch the tool using the button in the top toolbar.

The Find tool has several options:

**Match case:** Selects whether the search is case-sensitive.

**Words:** When selected, the search will only match the search term with complete words in the schematic. When unselected, the search will match if the search term is part of a larger word in the schematic.

**Wildcards:** When selected, wildcards can be used in the search terms. ? matches any single character, and * matches any number of characters. Note that when this option is selected, partial matches are not returned: searching for abc* will match the string abcd, but searching for abc will not.

**Search pin names and numbers:** Selects whether the search should apply to pin names and numbers.

**Search hidden fields:** Selects whether the search should apply only to visible fields or if it should include hidden symbol fields.

**Search the current sheet only:** Selects whether the search should be limited to the current schematic sheet or to the entire schematic.

There is also a Find and Replace tool which is activated with the button in the top toolbar. This tool behaves the same as the Find tool, but additionally can replace some or all matches with different text.
If the **Replace matches in reference designators** option is checked, reference designators will be modified if they contain matching text. Otherwise reference designators will not be affected.

**Net highlighting**

An electrical net can be highlighted in the schematic editor to visualize all of the places it appears in the schematic. Net highlighting can be activated in the Schematic Editor or by highlighting the corresponding net in the PCB editor when cross-probe highlighting is enabled (see below). When net highlighting is active, the highlighted net will be shown in a different color. By default this color is pink, but it is configurable in the Color section of the Preferences dialog.

Nets can be highlighted by clicking on a wire or pin using the Highlight Net tool in the right toolbar (\`). Alternatively, the Highlight Net hotkey (\`) highlights the net under the cursor. If there are no nets or pins under the cursor, any existing highlighting will be cleared. The highlighting can also be cleared by using the Clear Net Highlight action (hotkey \`).

**Cross-probing from the PCB**

KiCad allows bi-directional cross-probing between the schematic and the PCB. There are several different types of cross-probing.

**Selection cross-probing** allows you to select a symbol or pin in the schematic to select the corresponding footprint or pad in the PCB (if one exists) and vice-versa. By default, cross-probing will result in the display centering on the cross-probed item and zooming to fit. This behavior can be disabled in the Display Options section of the Preferences dialog.

**Highlight cross-probing** allows you to highlight a net in the schematic and PCB at the same time. If the option "Highlight cross-probed nets" is enabled in the Display Options section of the Preferences dialog, highlighting a net or bus in the schematic editor will cause the corresponding net or nets to be highlighted in the PCB editor, and vice versa.

**Design verification with Electrical Rules Check**

The Electrical Rules Check (ERC) tool performs an automatic check of your schematic. The ERC checks for any errors in your sheet, such as unconnected pins, unconnected hierarchical symbols, shorted outputs, etc. ERC output is reported as errors or warnings depending on the severity of the issue detected.
Naturally, an automatic check is not infallible, and it is not possible to detect all design errors. Such a check is still very useful, because it allows you to detect many oversights and small errors. All detected issues should be checked and addressed before proceeding.

The quality of the ERC is directly related to the care taken in declaring electrical pin properties during symbol library creation.

ERC can be started by clicking on the button in the top toolbar and clicking the Run ERC button.

Any warnings or errors are reported in the Violations tab, and markers for each violation are placed in the schematic so that they point to the relevant part of the schematic. Warnings are indicated by yellow arrows, and errors have red arrows. Excluded violations are shown as green arrows.

**NOTE** Selecting a violation in the ERC window jumps to the selected violation marker in the schematic.

The numbers at the bottom of the window show the number of errors, warnings, and exclusions. Each type of violation can be filtered from the list using the respective checkboxes. Clicking Delete Markers will clear all violations until ERC is run again.

Violations can be right-clicked in the dialog to ignore them or change their severity:
• **Exclude this violation**: ignores this particular violation, but does not affect any other violations.

• **Change severity**: changes a type of violation from warning to error, or error to warning. This affects all violations of a given type.

• **Ignore all**: ignores all violations of a given type.

**ERC example**

Here you can see three errors:

• Two outputs have been connected together (red arrow at right).

• Two inputs have been left unconnected (red arrows at left).

Selecting an ERC marker displays a description of the violation in the message pane at the bottom of the window.
Power pins and power flags

It is common to have an "Input Power pin not driven by any Output Power pins" error on power pins, as shown in the example below, even though the power pins seem to be properly connected to a power rail. This happens in designs where the power is provided through connectors or other components that are not marked as power outputs. In these cases ERC won't detect any Output Power pins connected to the net and will determine the Input Power pin is not driven by a power source.

To avoid this warning, connect the net to `PWR_FLAG` symbol on such a power net as shown in the following example. The `PWR_FLAG` symbol is found in the `power` symbol library. Alternatively, connect any power output pin to the net; `PWR_FLAG` is simply a symbol with a single power output pin.
Ground nets often need a PWR_FLAG as well, because voltage regulators have outputs declared as power outputs, but their ground pins are typically marked as power inputs. Therefore grounds can appear unconnected to a source unless a PWR_FLAG symbol is used.

For more information about power pins and power flags, see the PWR_FLAG documentation.

**ERC Configuration**

The *Pin Conflicts Map* panel in Schematic Setup allows you to configure connectivity rules to define electrical conditions for errors and warnings based on what types of pins are connected to each other.
Rules can be changed by clicking on the desired square of the matrix, causing it to cycle through the choices: normal, warning, error.

The Violation Severity panel in Schematic Setup lets you configure what types of ERC messages should be reported as Errors, Warnings or ignored.

**ERC report file**

An ERC report file can be generated and saved by clicking the Save... button in the ERC dialog. The file extension for ERC report files is .rpt. Here is an example ERC report file.

```
ERC report (Fri 21 Oct 2022 02:07:05 PM EDT, Encoding UTF8)

***** Sheet /
[pin_not_driven]: Input pin not driven by any Output pins
  ; Severity: error
  @(149.86 mm, 60.96 mm): Symbol U1B [74LS00] Pin 4 [, Input, Line]
[pin_not_connected]: Pin not connected
  ; Severity: error
  @(149.86 mm, 60.96 mm): Symbol U1B [74LS00] Pin 4 [, Input, Line]
[pin_not_connected]: Pin not connected
  ; Severity: error
  @(149.86 mm, 66.04 mm): Symbol U1B [74LS00] Pin 5 [, Input, Line]
[pin_to_pin]: Pins of type Output and Output are connected
  ; Severity: error
  @(165.10 mm, 63.50 mm): Symbol U1B [74LS00] Pin 6 [, Output, Inverted]
  @(165.10 mm, 46.99 mm): Symbol U1A [74LS00] Pin 3 [, Output, Inverted]
[pin_not_driven]: Input pin not driven by any Output pins
  ; Severity: error
  @(149.86 mm, 66.04 mm): Symbol U1B [74LS00] Pin 5 [, Input, Line]

** ERC messages: 5  Errors 5  Warnings 0
```
Assigning Footprints

Before routing a PCB, footprints need to be selected for every component that will be assembled on the board. Footprints define the copper connections between physical components and the routed traces on a circuit board.

Some symbols come with footprints pre-assigned, but for many symbols there are multiple possible footprints, so the user needs to select the appropriate one.

KiCad offers several ways to assign footprints:

- Symbol Properties
  - Symbol Properties Dialog
  - Symbol Fields Table
- While placing symbols
- Footprint Assignment Tool

Each method will be explained below. Which to use is a matter of preference; one method may be more convenient depending on the situation. All of these methods are equivalent in that they store the name of the selected footprint in the symbol's `Footprint` field.

NOTE

The Footprint Library Table needs to be configured before footprints can be assigned. For information on configuring the Footprint Library Table, please see the PCB Editor manual.

Assigning Footprints in Symbol Properties

A symbol's `Footprint` field can be edited directly in the symbol's Properties window.
Clicking the \[button\] in the **Footprint** field opens the Footprint Library Browser, which shows the available footprints and footprint libraries. Single clicking a footprint name selects the footprint and displays it in the preview pane on the right, while double clicking on a footprint closes the browser and sets the symbol's **Footprint** field to the selected footprint.

**Assigning Footprints with the Symbol Fields Table**

Rather than editing the properties of each symbol individually, the Symbol Fields Table can be used to view and edit the properties of all symbols in the design in one place. This includes assigning footprints by editing the **Footprint** field of each symbol.

The Symbol Fields Table is accessed with **Tools → Edit Symbol Fields...**, or with the \[button\] on the top toolbar.

The **Footprint** field behaves the same here as in the Symbol Properties window: it can be edited directly, or footprints can be selected visually with the Footprint Library Browser.
For more information on the Symbol Fields Table, see the section on editing symbol properties.

Assigning Footprints While Placing Symbols

Footprints can be assigned to symbols when the symbol is first added to the schematic.

Some symbols are defined with a default footprint. These symbols will have this footprint preassigned when they are added to the schematic. The default footprint is shown in the Add Symbol dialog. For symbols without a default symbol defined, the footprint dropdown will say "No default footprint", and the footprint preview canvas will say "No footprint specified".
Symbols can have footprint filters that specify which footprints are appropriate to use with that symbol. If footprint filters are defined for the selected symbol, all footprints that match the footprint filters will appear as options in the footprint dropdown. The selected footprint will be displayed in the preview canvas and will be assigned to the symbol when the symbol is added to the schematic.

**NOTE** Footprint options will not appear in the footprint dropdown unless the footprint libraries are loaded. Footprint libraries are loaded the first time the Footprint Editor or Footprint Library Browser are opened in a session.

For more information on footprint filters, see the Symbol Editor Documentation.

**Assigning Footprints with the Footprint Assignment Tool**

The Footprint Assignment Tool allows you to associate symbols in your schematic to footprints used when laying out the printed circuit board. It provides footprint list filtering, footprint viewing, and 3D component model viewing to help ensure the correct footprint is associated with each component.

Components can be assigned to their corresponding footprints manually or automatically by creating equivalence files (.equ files). Equivalence files are lookup tables associating each component with its footprint.

Run the tool with **Tools → Assign Footprints...**, or by clicking the icon in the top toolbar.
Footprint Assignment Tool Overview

The image below shows the main window of the Footprint Assignment Tool.

- The left pane contains the list of available footprint libraries associated with the project.
- The center pane contains the list of symbols in the schematic.
- The right pane contains the list of available footprints loaded from the project footprint libraries.
- The bottom pane describes the filters that have been applied to the footprint list and prints information about the footprint selected in the rightmost pane.

The top toolbar contains the following commands:
Transfer the current footprint associations to the schematic.

Edit the global and project footprint library tables.

View the selected footprint in the footprint viewer.

Select the previous symbol without a footprint association.

Select the next symbol without a footprint association.

Undo last edit.

Redo last edit.

Perform automatic footprint association using an equivalence file.

Delete all footprint assignments.

Filter footprint list by footprint filters defined in the selected symbol.

Filter footprint list by pin count of the selected symbol.

Filter footprint list by selected library.

The following table lists the keyboard commands for the Footprint Assignment Tool:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right Arrow /</td>
<td>Activate the pane to the right of the currently activated pane. Wrap</td>
</tr>
<tr>
<td>Tab</td>
<td>around to the first pane if the last pane is currently activated.</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Activate the pane to the left of the currently activated pane. Wrap</td>
</tr>
<tr>
<td></td>
<td>around to the last pane if the first pane is currently activated.</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Select the previous item of the currently selected list.</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Select the next item of the currently selected list.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Select the item one full page upwards of the currently selected item.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Select the item one full page downwards of the currently selected item.</td>
</tr>
<tr>
<td>Home</td>
<td>Select the first item of the currently selected list.</td>
</tr>
<tr>
<td>End</td>
<td>Select the last item of the currently selected list.</td>
</tr>
</tbody>
</table>

**Manually Assigning Footprints with the Footprint Assignment Tool**

To manually associate a footprint with a component, first select a component in the component (middle) pane. Then select a footprint in the footprint (right) pane by double-clicking on the name of the desired
footprint. The footprint will be assigned to the selected component, and the next component without an assigned footprint is automatically selected.

**NOTE** If no footprints appear in the footprint pane, check that the footprint filter options are correctly applied.

When all components have footprints assigned to them, click the **OK** button to save the assignments and exit the tool. Alternatively, click **Cancel** to discard the updated assignments, or **Apply, Save Schematic & Continue** to save the new assignments without exiting the tool.

### Filtering the Footprint List

There are four filtering options which restrict which footprints are displayed in the footprint pane. The filtering options are enabled and disabled with three buttons and a textbox in the top toolbar.

- **Activate** filters that can be defined in each symbol. For example, an opamp symbol might define filters that show only SOIC and DIP footprints.
- **Only show footprints that match the selected symbol's pin count.**
- **Only show footprints from the library selected in the left pane.**
- Entering text in the textbox hides footprints that do not match the text. This filter is disabled when the box is empty.

When all filters are disabled, the full footprint list is shown.

The applied filters are described in the bottom pane of the window, along with the number of footprints that meet the selected filters. For example, when the symbol's footprint filters and pin count filters are enabled, the bottom pane prints the footprint filters and pin count:

```
Connector_DIN 31 D2 -
LED : LED.THT:LED.DS.Hori,3.8,D pins 23
72 LED.THT:LED.DS.Hori,3.8,D pins 23
```

Multiple filters can be used at once to help narrow down the list of possibly appropriate footprints in the footprint pane. The symbols in KiCad’s standard library define footprint filters that are designed to be used in combination with the pin count filter.

### Automatically Assigning Footprints with the Footprint Assignment Tool

The Footprint Assignment Tool allows you to store footprint assignments in an external file and load the assignments later, even in a different project. This allows you to automatically associate symbols with the appropriate footprints.

The external file is referred to as an equivalence file, and it stores a mapping of a symbol value to a corresponding footprint. Equivalence files typically use the `.equ` file extension. Equivalence files are plain text files with a simple syntax, and must be created by the user using a text editor. The syntax is described below.

You can select which equivalence files to use by clicking **Preferences → Manage Footprint Association Files** in the Footprint Assignment Tool.
Add new equivalence files by clicking the Add button.

Remove the selected equivalence file by clicking the Remove button.

Change the priority of equivalence files by clicking the Move Up and Move Down buttons. If a symbol's value is found in multiple equivalence files, the footprint from the last matching equivalence file will override earlier equivalence files.

Open the selected equivalence file by clicking the Edit File button.

Relevant environment variables are shown at the bottom of the window. When the Relative path option is checked, these environment variables will automatically be used to make paths to selected equivalence files relative to the project or footprint libraries.

Once the desired equivalence files have been loaded in the correct order, automatic footprint association can be performed by clicking the button in the top toolbar of the Footprint Assignment Tool.
All symbols with a value found in a loaded equivalence file will have their footprints automatically assigned. However, symbols that already have footprints assigned will not be updated.

**Equivalence File Format**

Equivalence files consist of one line for each symbol value. Each line has the following structure:

'<<symbol value>>' '<<footprint library>:<footprint name>>'

Each name/value must be surrounded by single quotes (') and separated by one or more spaces. Lines starting with # are comments.

For example, if you want all symbols with the value LM4562 to be assigned the footprint Package_SO:SOIC-8_3.9x4.9_P1.27mm, the line in the equivalence file should be:

'LM4562' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

Here is an example equivalence file:

```
#integrated circuits (smd):
'74LV14' 'Package_SO:SOIC-14_3.9x8.7mm_P1.27mm'
'EL7242C' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'DS1302N' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'LM324N' 'Package_SO:SOIC-14_3.9x8.7mm_P1.27mm'
'LM358' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'LTC1878' 'Package_SO:MSOP-8_3x3mm_P0.65mm'
'24LC512I/SM' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'LM2903M' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'LT1129_SO8' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'LT1129_CS8-3.3' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'LT1129CS8' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'LM358M' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'TL7702BID' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'TL7702BCD' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'
'U2270B' 'Package_SO:SOIC-16_3.9x9.9_P1.27mm'

#regulators
'LP2985LV' 'Package_TO_SOT_SMD:SOT-23-5_HandSoldering'
```

**Viewing the Current Footprint**

The Footprint Assignment Tool contains a footprint viewer. Clicking the 🕵️ button in the top toolbar launches the footprint viewer and shows the selected footprint.
The top toolbar contains the following commands:

- **Refresh view**
- **Zoom in**
- **Zoom out**
- **Zoom to fit drawing in display area**
- **Show 3D viewer**

The left toolbar contains the following commands:
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Arrow]</td>
<td>Use the select tool</td>
</tr>
<tr>
<td>![Ruler]</td>
<td>Interactively measure between two points</td>
</tr>
<tr>
<td>![Grid]</td>
<td>Display grid dots or lines</td>
</tr>
<tr>
<td>![Polar]</td>
<td>Switch between polar and cartesian coordinate systems</td>
</tr>
<tr>
<td>![Inches]</td>
<td>Use inches</td>
</tr>
<tr>
<td>![Mils]</td>
<td>Display coordinates in mils (1/1000 of an inch)</td>
</tr>
<tr>
<td>![Millimeters]</td>
<td>Display coordinates in millimeters</td>
</tr>
<tr>
<td>![Crosshairs]</td>
<td>Toggle display of full-window crosshairs</td>
</tr>
<tr>
<td>![Sketch]</td>
<td>Toggle between drawing pads in sketch or normal mode</td>
</tr>
<tr>
<td>![Normal]</td>
<td>Toggle between drawing pads in normal mode or outline mode</td>
</tr>
<tr>
<td>![Text]</td>
<td>Toggle between drawing text in normal mode or outline mode</td>
</tr>
<tr>
<td>![Graphic]</td>
<td>Toggle between drawing graphic lines in normal mode or outline mode</td>
</tr>
</tbody>
</table>

**Viewing the Current 3D Model**

Clicking the ![3D Model] button opens the footprint in the 3D model viewer.

**NOTE**

If a 3D model does not exist for the current footprint, only the footprint itself will be shown in the 3D Viewer.
The 3D Viewer is described in the PCB Editor manual.
Transferring designs between schematic and PCB

Update PCB from Schematic

Use the Update PCB from Schematic tool to sync design information from the Schematic Editor to the Board Editor. The tool can be accessed with Tools → Update PCB from Schematic in both the schematic and board editors. You can also use the icon in the top toolbar of the Board Editor.

NOTE

Update PCB from Schematic is the preferred way to transfer design information from the schematic to the PCB. In older versions of KiCad, the equivalent process was to export a netlist from the Schematic Editor and import it into the Board Editor. It is no longer necessary to use a netlist file.

The tool adds the footprint for each symbol to the board and transfers updated schematic information to the board. In particular, the board’s net connections are updated to match the schematic.

The changes that will be made to the PCB are listed in the Changes To Be Applied pane. The PCB is not modified until you click the Update PCB button.

You can show or hide different types of messages using the checkboxes at the bottom of the window. A report of the changes can be saved to a file using the Save... button.
Options
The tool has several options to control its behavior.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Re-link footprints to schematic symbols based on their reference designators</td>
<td>Footprints are normally linked to schematic symbols via a unique identifier created when the symbol is added to the schematic. A symbol's unique identifier cannot be changed. If checked, each footprint in the PCB will be re-linked to the symbol that has the same reference designator as the footprint. If unchecked, footprints and symbols will be linked by unique identifier as usual, rather than by reference designator. Each footprint's reference designator will be updated to match the reference designator of its linked symbol. This option should generally be left unchecked. It is useful for specific workflows that rely on changing the links between schematic symbols and footprints, such as refactoring a schematic for easier layout or replicating layout between identical channels of a design.</td>
</tr>
<tr>
<td>Delete footprints with no symbols</td>
<td>If checked, any footprint in the PCB without a corresponding symbol in the schematic will be deleted from the PCB. Footprints with the &quot;Not in schematic&quot; attribute will be unaffected. If unchecked, footprints without a corresponding symbol will not be deleted.</td>
</tr>
<tr>
<td>Replace footprints with those specified in the schematic</td>
<td>If checked, footprints in the PCB will be replaced with the footprint that is specified in the corresponding schematic symbol. If unchecked, footprints that are already in the PCB will not be changed, even if the schematic symbol is updated to specify a different footprint.</td>
</tr>
</tbody>
</table>

Update Schematic from PCB

NOTE | TODO: write this section

Backannotation with CMP files
Select changes can also be synced from the PCB back to the schematic by exporting a CMP file from the PCB editor (File → Export → Footprint Association (.cmp) File...) and importing it in the Schematic Editor (File → Import → Footprint Assignments...).

NOTE | This method can only sync changes made to footprint assignments and footprint fields. It is recommended to use the Update Schematic from PCB tool instead.
Generating Outputs

Printing

KiCad can print the schematic to a standard printer using File → Print…

- **Print sheet reference and title block**: Include the drawing sheet border and title block in the printed schematic.
- **Print in black and white only**: Print the schematic in black and white rather than color.
- **Print background color**: Include the background color in the printed schematic. This option is only enabled if Print in black and white only is disabled.
- **Use a different color theme for printing**: Select a different color scheme for printing than the one selected for display in the Schematic Editor.

- **Page Setup…**: Opens a page setup dialog for setting paper size and orientation.
- **Preview**: Opens a print preview dialog.
- **Close**: Closes the dialog without printing.
- **Print**: Opens the system print dialog.

**NOTE**

Printing uses platform- and printer-specific drivers and may have unexpected results. When printing to a file, *Plotting* is recommended instead of *Printing*.

Plotting

KiCad can plot schematics to a file using File → Plot…
The supported output formats are Postscript, PDF, SVG, DXF, and HPGL.

The **Output Messages** pane displays messages about the generated files. Different kinds of messages can be shown or hidden using the checkboxes, and the messages can be saved to a file using the **Save...** button.

The **Plot Current Page** button plots the current page of the schematic. The **Plot All Pages** button plots all pages of the schematic. One file is generated for each page, except for PDF output, which plots each schematic page as a separate page in a single PDF file.

**Plotting options**

**Output directory:** Specify the location to save plotted files. If this is a relative path, it is created relative to the project directory.

**Output Format:** Select the format to plot in. Some formats have different options than others.

**Page size:** Sets the page size to use for the plotted output. This can be set to match the schematic size or to another sheet size.

**Plot drawing sheet:** Include the drawing sheet border and title block in the printed schematic.

**Output mode:** Sets the output to color or black and white. Not all output formats support color.

**Plot background color:** Includes the schematic background color in the plotted output. The background color will not be plotted if the output format does not support color or the output mode is black and white.

**Color theme:** Selects the color theme to use for the plotted output.
Default line width: Selects the default width for lines without a specified thickness (lines that have thickness set to 0). Lines that have a set thickness will be plotted at that thickness instead.

Position and units: Sets the plotter origin and units. This option only applies for HPGL output.

Pen width: Sets the plotter's pen width. This option only applies for HPGL output.

Generating a Bill of Materials

KiCad can generate a Bill of Materials using Tools → Generate BOM... or the button on the top toolbar. The generated BOM lists all of the components in the design.

The BOM tool uses an external script to process the design information into the desired output format. Several BOM generator scripts are included with KiCad, and users can also create their own. BOM generator scripts generally use Python or XSLT, but other tools can be used as long as you can specify a command line for KiCad to execute when running the generator.

You can select which BOM generator to use in the BOM generator scripts list. The rest of the dialog displays information about the selected generator. You can change the displayed name of the generator with the Generator nickname textbox.

The pane at right displays information about the selected script. When the generator is executed, the right pane instead displays output from the script.

The text box at the bottom contains the command that KiCad will use to execute the generator. It is automatically populated when a script is selected, but the command may need to be hand-edited for some generators. KiCad saves the command line for each generator when the BOM tool is closed, so command line customizations are preserved. For more details about the command line, see the advanced documentation.

On Windows, the BOM Generator dialog has an additional option Show console window. When this option is unchecked, BOM generators run in a hidden console window and any output is redirected and printed in
the dialog. When this option is checked, BOM generators run in a visible console window, which may be necessary if the generator plugin provides a graphical user interface.

**BOM generator scripts**

By default, the BOM tool presents two output script options.

- **bom_csv_grouped_by_value** outputs a CSV with two sections. The first section contains every component in the design, with a single component on each line. The second section also contains every component, but components are grouped by symbol name, value, and footprint. The columns in the BOM are:
  - Line item number
  - Quantity
  - Reference designator(s)
  - Value
  - Symbol library and symbol name
  - Footprint
  -Datasheet
  - Any other symbol fields

- **bom_csv_grouped_by_value_with_fp** outputs a CSV with a single section containing every component in the design. Components are grouped by value and footprint. The columns in the BOM are:
  - Reference designator(s)
  - Quantity
  - Value
  - Symbol name
  - Footprint
  - Symbol description
  - Vendor

Additional generator scripts are installed with KiCad but are not populated in the generator script list by default. The location of these scripts depends on the operating system and may vary based on installation location.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>C:\Program Files\KiCad\6.0\bin\scripting\plugins\</td>
</tr>
<tr>
<td>Linux</td>
<td>/usr/share/kicad/plugins/</td>
</tr>
<tr>
<td>macOS</td>
<td>/Applications/KiCad/KiCad.app/Contents/SharedSupport/plugins/</td>
</tr>
</tbody>
</table>

Additional scripts can be added to the list of BOM generator scripts by clicking the button. Scripts can be removed by clicking the button. The button opens the selected script in a text editor.
For more information on creating and using custom BOM generators, see the advanced documentation.

Netlists

A netlist is a file which describes electrical connections between symbol pins. These connections are referred to as nets. Netlist files contain:

- A list of symbols and their pins.
- A list of connections (nets) between symbol pins.

Many different netlist formats exist. Sometimes the symbols list and the list of nets are two separate files. This netlist is fundamental in the use of schematic capture software, because the netlist is the link with other electronic CAD software, such as PCB layout software, simulators, and programmable logic compilers.

KiCad supports several netlist formats:

- KiCad format, which can be imported by the KiCad PCB Editor. However, the "Update PCB from Schematic" tool should be used instead of importing a KiCad netlist into the PCB editor.
- OrCAD PCB2 format, for designing PCBs with OrCAD.
- CADSTAR format, for designing PCBs with CADSTAR.
- Spice format, for use with various external circuit simulators.

**NOTE**

In KiCad version 5.0 and later, it is not necessary to create a netlist for transferring a design from the schematic editor to the PCB editor. Instead, use the "Update PCB from Schematic" tool.

**NOTE**

Other software tools that use netlists may have restrictions on spaces and special characters in component names, pins, nets, and other fields. For compatibility, be aware of such restrictions in other tools you plan to use, and name components, nets, etc. accordingly.

Netlist formats

Netlists are exported with the Export Netlist dialog (File → Export → Netlist...).
KiCad supports exporting netlists in several formats: KiCad, OrcadPCB2, CADSTAR, and Spice. Each format can be selected by selecting the corresponding tab at the top of the window. Some netlist formats have additional options.

Clicking the **Export Netlist** button prompts for a netlist filename and saves the netlist.

**NOTE**  Netlist generation can take up to several minutes for large schematics.

Custom generators for other netlist formats can be added by clicking the **Add Generator...** button. Custom generators are external tools that are called by KiCad, for example Python scripts or XSLT stylesheets. For more information on custom netlist generators, see the section on adding custom netlist generators.

**Spice Netlist Format**

The Spice netlist format offers several options.

When the **Reformat passive symbol values** box is checked, passive symbol values will be adjusted to be compatible with Spice. Specifically:

- μ and M as unit prefixes are replaced with u and Meg, respectively
- Units are removed (e.g. 4.7kΩ is changed to 4.7k)
- Values in RKM format are rewritten to be Spice-compatible (e.g. 4u7 is changed to 4.7u)

The Spice netlist exporter also provides an easy way to simulate the generated netlist with an external simulator. This can be useful for running a simulation without using KiCad's internal ngspice simulator, or for running an ngspice simulation with options that are not supported by KiCad's simulator tool.

Enter the path to the external simulator in the text box, with %I representing the generated netlist. Click the **Create Netlist and Run Simulator Command** button to generate the netlist and automatically run the simulator.

**NOTE**  The default simulator command (spice "%I") must be adjusted to point to a simulator installed on your system.
Spice simulators expect simulation commands (.PROBE, .AC, .TRAN, etc.) to be included in the netlist. Any text line included in the schematic diagram starting with a period (.) will be included in the netlist. If a text object contains multiple lines, only the lines beginning with a period will be included.

.include directives for including model library files are automatically added to the netlist based on the Spice model settings for the symbols in the schematic.

Netlist examples
Below is the schematic from the sallen_key project included in KiCad's simulation demos.

The KiCad format netlist for this schematic is as follows:
(design
(source "/usr/share/kicad/demos/simulation/sallen_key/sallen_key.kicad_sch"
(date "Sun 01 May 2022 03:14:05 PM EDT"
(tool "Eeschema (6.0.4)"
(sheet (number "1") (name "/") (tstamps "/")
 (title_block
  (title)
  (company)
  (rev)
  (date)
  (source "sallen_key.kicad_sch"
   (comment (number "1") (value ""))
   (comment (number "2") (value ""))
   (comment (number "3") (value ""))
   (comment (number "4") (value ""))
   (comment (number "5") (value ""))
   (comment (number "6") (value ""))
   (comment (number "7") (value ""))
   (comment (number "8") (value ""))
   (comment (number "9") (value ""))))
 (components
 (comp (ref "C1")
   (value "100n")
   (libsource (lib "sallen_key_schlib") (part "C") (description ""))
   (property (name "Sheetname") (value ""))
   (property (name "Sheetfile") (value "sallen_key.kicad_sch")
   (sheetpath (names "/") (tstamps "/")
   (tstamps "00000000-0000-0000-0000-00005789077d"))
 (comp (ref "C2")
   (value "100n")
   (fields
    (field (name "Fieldname") "Value")
    (field (name "SpiceMapping") "1 2")
    (field (name "Spice_Primitive") "C")
   (libsource (lib "sallen_key_schlib") (part "C") (description ""))
   (property (name "Fieldname") (value "Value"))
   (property (name "Spice_Primitive") (value "C"))
   (property (name "SpiceMapping") (value "1 2"))
   (property (name "Sheetname") (value ""))
   (property (name "Sheetfile") (value "sallen_key.kicad_sch")
   (sheetpath (names "/") (tstamps "/")
   (tstamps "00000000-0000-0000-0000-00005789085b"))
 (comp (ref "R1")
   (value "1k")
   (fields
    (field (name "Fieldname") "Value")
    (field (name "SpiceMapping") "1 2")
    (field (name "Spice_Primitive") "R")
   (libsource (lib "sallen_key_schlib") (part "R") (description ""))
   (property (name "Fieldname") (value "Value"))
   (property (name "SpiceMapping") (value "1 2"))
   (property (name "Spice_Primitive") (value "R"))
   (property (name "Sheetname") (value ""))
   (property (name "Sheetfile") (value "sallen_key.kicad_sch")
   (sheetpath (names "/") (tstamps "/")
   (tstamps "00000000-0000-0000-0000-0000578906ff"))
 (comp (ref "R2")
   (value "1k")
   (fields
    (field (name "Fieldname") "Value")
    (field (name "SpiceMapping") "1 2")
)
In Spice format, the netlist is as follows:

```
.title KiCad schematic
.include "ad8051.lib"
XU1 Net-_C2-Pad1_ /lowpass VDD VSS /lowpass AD8051
C2 Net-_C2-Pad1_ GND 100n
C1 /lowpass Net-_C1-Pad2_ 100n
R2 Net-_C2-Pad1_ Net-_C1-Pad2_ 1k
R1 Net-_C1-Pad2_ Net-_R1-Pad2_ 1k
V1 Net-_R1-Pad2_ GND AC 1
V2 VDD GND DC 10
V3 GND VSS DC 10
.ac dec 10 1 1Meg
.end
```
Managing Symbol Libraries

Symbol libraries hold collections of symbols used when creating schematics. Each symbol in a schematic is uniquely identified by a full name that is composed of a library nickname and a symbol name. An example is `Audio:AD1853`.

Symbol Library Table

KiCad uses a table of symbol libraries to map symbol libraries to a library nickname. KiCad uses a global symbol library table as well as a table specific to each project. To edit either symbol library table, use `Preferences → Manage Symbol Libraries`.

The global symbol library table contains the list of libraries that are always available regardless of the currently loaded project. The table is saved in the file `sym-lib-table` in the KiCad configuration folder. The location of this folder depends on the operating system being used.

The project specific symbol library table contains the list of libraries that are available specifically for the currently loaded project. If there are any project-specific symbol libraries, the table is saved in the file `sym-lib-table` in the project folder.

Initial Configuration

The first time the KiCad Schematic Editor is run and the global symbol table file `sym-lib-table` is not found in the KiCad configuration folder, KiCad will guide the user through setting up a new symbol library table. This process is described above.
Managing Table Entries

Symbol libraries can only be used if they have been added to either the global or project-specific symbol library table.

Add a library either by clicking the button and selecting a library or clicking the button and typing the path to a library file. The selected library will be added to the currently opened library table (Global or Project Specific). Libraries can be removed by selecting desired library entries and clicking the button.

The ↑ and ↓ buttons move the selected library up and down in the library table. This does not affect the display order of libraries in the Symbol Library Browser, Symbol Editor, or Add Symbol tool.

Libraries can be made inactive by unchecking the Active checkbox in the first column. Inactive libraries are still in the library table but do not appear in any library browsers and are not loaded from disk, which can reduce loading times.

A range of libraries can be selected by clicking the first library in the range and then [Shift]-clicking the last library in the range.

Each library must have a unique nickname: duplicate library nicknames are not allowed in the same table. However, nicknames can be duplicated between the global and project library tables. Libraries in the project table take precedence over libraries with the same name in the global table.

Library nicknames do not have to be related to the library filename or path. The colon character (:) cannot be used in library nicknames or symbol names because it is used as a separator between nicknames and symbols.

Each library entry must have a valid path. Paths can be defined as absolute, relative, or by environment variable substitution.

The appropriate library format must be selected in order for the library to be properly read. "KiCad" format is used for KiCad version 6 libraries (.kicad_sym files), while "Legacy" format is used for libraries from older versions of KiCad (.lib files). Legacy libraries are read-only, but can be migrated to KiCad format libraries using the Migrate Libraries button (see section Migrating Legacy Libraries).

There is an optional description field to add a description of the library entry. The option field is not used at this time so adding options will have no effect when loading libraries.

Environment Variable Substitution

The symbol library tables support environment variable substitution, which allows you to define environment variables containing custom paths to where your libraries are stored. Environment variable substitution is supported by using the syntax $\{ENV\_VAR\_NAME\}$ in the symbol library path.

By default, KiCad defines several environment variables:

- $\{KIPROJMOD\}$ points to the current project directory and cannot be modified.
- $\{KICAD6\_FOOTPRINT\_DIR\}$ points to the default location of KiCad's standard footprint libraries.
- $\{KICAD6\_SYMBOL\_DIR\}$ points to the default location of KiCad's standard symbol libraries.
- $\{KICAD6\_3DMODEL\_DIR\}$ points to the default location of KiCad's standard 3D model libraries.
${KICAD6 TEMPLATE_DIR} points to the default location of KiCad's standard template library.

${KIPROJMOD} cannot be redefined, but the other environment variables can be redefined and new environment variables added in the Preferences → Configure Paths... dialog.

Using environment variables in the symbol library tables allows libraries to be relocated without breaking the symbol library tables, so long as the environment variables are updated when the library location changes.

${KIPROJMOD} allows libraries to be stored in the project folder without having to use an absolute path in the project library table. This makes it possible to relocate projects without breaking their project library tables. One of the most powerful features of the symbol library table is environment variable substitution. This allows for definition of custom paths to where symbol libraries are stored in environment variables. Environment variable substitution is supported by using the syntax ${ENV_VAR_NAME} in the library path.

Usage Patterns

Symbol libraries can be defined either globally or specifically to the currently loaded project. Symbol libraries defined in the user's global table are always available and are stored in the sym-lib-table file in the user's KiCad configuration folder. The project-specific symbol library table is active only for the currently open project file.

There are advantages and disadvantages to each method. Defining all libraries in the global table means they will always be available when needed. The disadvantage of this is that load time will increase.

Defining all symbol libraries on a project specific basis means that you only have the libraries required for the project which decreases symbol library load times. The disadvantage is that you always have to remember to add each symbol library that you need for every project.

One usage pattern would be to define commonly used libraries globally and the libraries only required for the project in the project specific library table. There is no restriction on how to define libraries.

Migrating Legacy Libraries

Legacy libraries (.lib files) are read-only, but they can be migrated to KiCad version 6 libraries (.kicad_sym). KiCad version 6 libraries cannot be viewed or edited by KiCad versions older than 6.0.0.

Legacy libraries can be converted to KiCad 6 libraries by selecting them in the symbol library table and clicking the Migrate Libraries button. Multiple libraries can be selected and migrated at once by Ctrl-clicking or shift-clicking.

Libraries can also be converted one at a time by opening them in the Symbol Editor and saving them as a new library.

Legacy Project Remapping

When loading a schematic created prior to the symbol library table implementation, KiCad will attempt to remap the symbol library links in the schematic to the appropriate library table symbols. The success of this process is dependent on several factors:

- the original libraries used in the schematic are still available and unchanged from when the symbol was added to the schematic.

all rescue operations were performed when detected to create a rescue library or keep the existing rescue library up to date.

- the integrity of the project symbol cache library has not been corrupted.

| WARNING | The remapping will make a back up of all the files that are changed during remapping in the rescue-backup folder in the project folder. Always make a back up of your project before remapping just in case something goes wrong. |

| WARNING | The rescue operation is performed even if it has been disabled to ensure the correct symbols are available for remapping. Do not cancel this operation or the remapping will fail to correctly remap schematics symbols. Any broken symbol links will have to be fixed manually. |

| NOTE | If the original libraries have been removed and the rescue was not performed, the cache library can be used as a recovery library as a last resort. Copy the cache library to a new file name and add the new library file to the top of the library list using a version of KiCad prior to the symbol library table implementation. |
Symbol Editor

General Information About Symbol Libraries

A symbol is a schematic element which contains a graphical representation, electrical connections, and text fields describing the symbol. Symbols used in a schematic are stored in symbol libraries. KiCad provides a symbol editing tool that allows you to create libraries, add, delete or transfer symbols between libraries, export symbols to files, and import symbols from files. The symbol editing tool provides a simple way to manage symbols and symbol libraries.

Symbol Library Overview

A symbol library is composed of one or more symbols. Generally the symbols are logically grouped by function, type, and/or manufacturer.

A symbol is composed of:

- Graphical items (lines, circles, arcs, text, etc.) that determine how symbol looks in a schematic.
- Pins which have both graphic properties (line, clock, inverted, low level active, etc.) and electrical properties (input, output, bidirectional, etc.) used by the Electrical Rules Check (ERC) tool.
- Fields such as references, values, corresponding footprint names for PCB design, etc.

Symbols can be derived from another symbol in the same library. Derived symbols share the base symbol's graphical shape and pin definitions, but can override the base symbol's property fields (value, footprint, footprint filters, datasheet, description, etc.). Derived symbols can be used to define symbols that are similar to a base part. For example, 74LS00, 74HC00, and 7437 symbols could all be derived from a 7400 symbol. In previous versions of KiCad, derived symbols were referred to as aliases.

Proper symbol designing requires:

- Defining if the symbol is made up of one or more units.
- Defining if the symbol has an alternate body style (also known as a De Morgan representation).
- Designing its symbolic representation using lines, rectangles, circles, polygons and text.
- Adding pins by carefully defining each pin's graphical elements, name, number, and electrical property (input, output, tri-state, power port, etc.).
- Determining if the symbol should be derived from another symbol with the same graphical design and pin definition.
- Adding optional fields such as the name of the footprint used by the PCB design software and/or defining their visibility.
- Documenting the symbol by adding a description string and links to data sheets, etc.
- Saving it in the desired library.

Symbol Library Editor Overview

The symbol library editor main window is shown below. It consists of three tool bars for quick access to common features and a symbol viewing/editing area. Not all commands are available on the tool bars but
can be accessed using the menus.

Main Toolbar

The main tool bar is located at the top of the main window. It consists of the undo/redo commands, zoom commands, symbol properties dialogs, and unit/representation management controls.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new symbol</td>
<td>Create a new symbol in the selected library.</td>
</tr>
<tr>
<td>Save library</td>
<td>Save the currently selected library. All modified symbols in the library will be saved.</td>
</tr>
<tr>
<td>Undo</td>
<td>Undo last edit.</td>
</tr>
<tr>
<td>Redo</td>
<td>Redo last undo.</td>
</tr>
<tr>
<td>Refresh display</td>
<td>Refresh display.</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Zoom in.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Zoom out.</td>
</tr>
<tr>
<td>Zoom to fit</td>
<td>Zoom to fit symbol in display.</td>
</tr>
<tr>
<td>Zoom to fit</td>
<td>Zoom to fit selection.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotate counter-clockwise.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotate clockwise.</td>
</tr>
<tr>
<td>Mirror</td>
<td>Mirror horizontally.</td>
</tr>
<tr>
<td>Mirror</td>
<td>Mirror vertically.</td>
</tr>
<tr>
<td>Edit symbol properties</td>
<td>Edit the current symbol properties.</td>
</tr>
<tr>
<td>Edit pins</td>
<td>Edit the symbol's pins in a tabular interface.</td>
</tr>
<tr>
<td>Open datasheet</td>
<td>Open the symbol's datasheet. The button will be disabled if no datasheet is defined for the current symbol.</td>
</tr>
<tr>
<td>Test symbol</td>
<td>Test the current symbol for design errors.</td>
</tr>
<tr>
<td>Normal body style</td>
<td>Select the normal body style. The button is disabled if the current symbol does not have an alternate body style.</td>
</tr>
<tr>
<td>Alternate body style</td>
<td>Select the alternate body style. The button is disabled if the current symbol does not have an alternate body style.</td>
</tr>
<tr>
<td>Select unit</td>
<td>Select the unit to display. The drop down control will be disabled if the current symbol is not derived from a symbol with multiple units.</td>
</tr>
<tr>
<td>Synchronized pins</td>
<td>Enable synchronized pins edit mode. When this mode is enabled, any pin modifications are propagated to all other symbol units. Pin number changes are not propagated. This mode is automatically enabled for symbols with multiple interchangeable units and cannot be enabled for symbols with only one unit.</td>
</tr>
</tbody>
</table>
**Element Toolbar**

The vertical toolbar located on the right hand side of the main window allows you to place all of the elements required to design a symbol.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select tool</td>
<td>Right-clicking with the select tool opens the context menu for the object under the cursor. Left-clicking with the select tool displays the</td>
</tr>
<tr>
<td></td>
<td>attributes of the object under the cursor in the message panel at the bottom of the main window. Double-left-clicking with the select tool will</td>
</tr>
<tr>
<td></td>
<td>open the properties dialog for the object under the cursor.</td>
</tr>
<tr>
<td>Pin tool</td>
<td>Left-click to add a new pin.</td>
</tr>
<tr>
<td>Graphical text tool</td>
<td>Left-click to add a new graphical text item.</td>
</tr>
<tr>
<td>Rectangle tool</td>
<td>Left-click to begin drawing the first corner of a graphical rectangle. Left-click again to place the opposite corner of the rectangle.</td>
</tr>
<tr>
<td>Circle tool</td>
<td>Left-click to begin drawing a new graphical circle from the center. Left-click again to define the radius of the circle.</td>
</tr>
<tr>
<td>Arc tool</td>
<td>Left-click to begin drawing a new graphical arc item from the first arc end point. Left-click again to define the second arc end point.</td>
</tr>
<tr>
<td></td>
<td>Adjust the radius by dragging the arc center point.</td>
</tr>
<tr>
<td>Connected line tool</td>
<td>Left-click to begin drawing a new graphical line item in the current symbol. Left-click for each additional connected line.</td>
</tr>
<tr>
<td>Anchor tool</td>
<td>Left-click to set the anchor position of the symbol.</td>
</tr>
<tr>
<td>Delete tool</td>
<td>Left-click to delete an object from the current symbol.</td>
</tr>
</tbody>
</table>

**Options Toolbar**

The vertical tool bar located on the left hand side of the main window allows you to set some of the editor drawing options.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>Toggle grid visibility on and off.</td>
</tr>
<tr>
<td>Inches</td>
<td>Set units to inches.</td>
</tr>
<tr>
<td>Mil</td>
<td>Set units to mils (0.001 inch).</td>
</tr>
<tr>
<td>Millimeters</td>
<td>Set units to millimeters.</td>
</tr>
<tr>
<td>Full screen</td>
<td>Toggle full screen cursor on and off.</td>
</tr>
<tr>
<td>Electrical</td>
<td>Toggle display of pin electrical types.</td>
</tr>
<tr>
<td>Libraries</td>
<td>Toggle display of libraries and symbols.</td>
</tr>
</tbody>
</table>
Library Selection and Maintenance

The selection of the current library is possible via the icon which shows you all available libraries and allows you to select one. When a symbol is loaded or saved, it will be put in this library. The library name of a symbol is the contents of its Value field.

Select and Save a Symbol

Symbol Selection

Clicking the icon on the left tool bar toggles the treeview of libraries and symbols. Clicking on a symbol opens that symbol.

NOTE

Some symbols are derived from other symbols. Derived symbol names are displayed in *italics* in the treeview. If a derived symbol is opened, its symbol graphics will not be editable. Its symbol fields will be editable as normal. To edit the graphics of a base symbol and all of its derived symbols, open the base symbol.

Save a Symbol

After modification, a symbol can be saved in the current library or a different library.

To save the modified symbol in the current library, click the icon. The modifications will be written to the existing symbol.

NOTE

Saving a modified symbol also saves all other modified symbols in the same library.

To save the symbol changes to a new symbol, click File → Save As.... The symbol can be saved in the current library or a different library. A new name can be set for the symbol.

To create a new file containing only the current symbol, click File → Export → Symbol.... This file will be a standard library file which will contain only one symbol.

Creating Library Symbols

Create a New Symbol

A new symbol can be created by clicking the icon. You will be asked for a number of symbol properties.

- A symbol name (this name is used as the default value for the Value field in the schematic editor)
- An optional base symbol to derive the new symbol from. The new symbol will use the base symbol's graphical shape and pin configuration, but other symbol information can be modified in the derived symbol. The base symbol must be in the same library as the new derived symbol.
- The reference designator prefix (U, C, R...).
- The number of units per package, and whether those units are interchangeable (for example a 7400 is made of 4 units per package).
- If an alternate body style (sometimes referred to as a "De Morgan equivalent") is desired.
- Whether the symbol is a power symbol. Power symbols appear in the "Add Power Port" dialog in the Schematic editor, their Value fields are not editable in the schematic, they cannot be assigned a
footprint and they are not added to the PCB, and they are not included in the bill of materials.

- Whether the symbol should be excluded from the bill of materials.
- Whether the symbol should be excluded from the PCB.

There are also several graphical options.

- The offset between the end of each pin and its pin name.
- Whether the pin number and pin name should be displayed.
- Whether the pin names should be displayed alongside the pins or at the ends of the pins inside the symbol body.

These properties can also be changed later in the Symbol Properties window.

![Symbol Properties window](image)

A new symbol will be created using the properties above and will appear in the editor as shown below.
The blue cross in the center is the symbol anchor, which specifies the symbol origin i.e. the coordinates (0, 0). The anchor can be repositioned by selecting the icon and clicking on the new desired anchor position.

Create a Symbol from Another Symbol

Often, the symbol that you want to make is similar to one already in a symbol library. In this case it is easy to load and modify an existing symbol.

- Load the symbol which will be used as a starting point.
- Save a new copy of the symbol using File → Save As.... The Save As dialog will prompt for a name for the new symbol and the library to save it in.
- Edit the new symbol as required.
- Save the modified symbol.

Symbol Properties

Symbol properties are set when the symbol is created but they can be modified at any point. To change the symbol properties, click on the icon to show the dialog below.
It is important to correctly set the number of units per package and the alternate symbolic representation, if enabled, because when pins are edited or created the corresponding pins for each unit will be affected. If you change the number of units per package after pin creation and editing, there will be additional work to specify the pins and graphics for the new unit. Nevertheless, it is possible to modify these properties at any time.

The graphic options "Show pin number" and "Show pin name" define the visibility of the pin number and pin name text. The option "Place pin names inside" defines the pin name position relative to the pin body. The pin names will be displayed inside the symbol outline if the option is checked. In this case the "Pin Name Position Offset" property defines the shift of the text away from the body end of the pin. A value from 0.02 to 0.05 inches is usually reasonable.

The example below shows a symbol with the "Place pin name inside" option unchecked. Notice the position of the names and pin numbers.
Symbol Name, Description, and Keywords

The symbol's name is the same as the Value field. When the symbol name is changed the value also changes, and vice versa. The symbol's name in the library also changes accordingly.

The symbol description should contain a brief description of the component, such as the component function, distinguishing features, and package options. The keywords should contain additional terms related to the component. Keywords are used primarily to assist in searching for the symbol.
A symbol's name, description, and keywords are all used when searching for symbols in the Symbol Editor and Add a Symbol dialog. The description and keywords are displayed in the Symbol Library Browser and Add a Symbol dialog.

**Footprint Filters**

The footprint filters tab is used to define which footprints are appropriate to use with the symbol. The filters can be applied in the Footprint Assignment tool so that only appropriate footprints are displayed for each symbol.

Multiple footprint filters can be defined. Footprints that match any of the filters will be displayed; if no filters are defined, then all footprints will be displayed.

Filters can use wildcards: * matches any number of characters, including zero, and ? matches zero or one characters. For example, SOIC-* would match the SOIC-8.3,9x4.9mm_P1.27mm footprint as well as any other footprint beginning with SOIC-. The filter SOT?23 matches SOT23 as well as SOT-23.
Symbols with Alternate Symbolic Representation

If the symbol has an alternate body style defined, one body style must be selected for editing at a time. To edit the normal representation, click the icon.

To edit the alternate representation, click on the icon. Use the dropdown shown below to select the unit you wish to edit.
Graphical Elements

Graphical elements create the visual representation of a symbol and contain no electrical connection information. Graphical elements are created with the following tools:

- Lines and polygons defined by start and end points.
- Rectangles defined by two diagonal corners.
- Circles defined by the center and radius.
- Arcs defined by the starting and ending point of the arc and its center. An arc goes from 0° to 180°.

The vertical toolbar on the right hand side of the main window allows you to place all of the graphical elements required to design the representation of a symbol.

Graphical Element Membership

Each graphic element (line, arc, circle, etc.) can be defined as common to all units and/or body styles or specific to a given unit and/or body style. Element options can be quickly accessed by right-clicking on the element to display the context menu for the selected element. Below is the context menu for a line element.
You can also double-left-click on an element to modify its properties. Below is the properties dialog for a polygon element.
The properties of a graphic element are:

- **"Line width"** defines the width of the element’s line in the current drawing units.
- **"Fill Style"** determines if the shape defined by the graphical element is to be drawn unfilled, background filled, or foreground filled.
- **"Common to all units in symbol"** determines if the graphical element is drawn for each unit in symbol with more than one unit per package or if the graphical element is only drawn for the current unit.
- **"Common to all body styles (De Morgan)"** determines if the graphical element is drawn for each symbolic representation in symbols with an alternate body style or if the graphical element is only drawn for the current body style.

### Graphical Text Elements

The **T** icon allows for the creation of graphical text. Graphical text is automatically oriented to be readable, even when the symbol is mirrored. Please note that graphical text items are not the same as symbol fields.

### Multiple Units per Symbol and Alternate Body Styles

Symbols can have up to two body styles (a standard symbol and an alternate symbol often referred to as a "De Morgan equivalent") and/or have more than one unit per package (logic gates for example). Some symbols can have more than one unit per package each with different symbols and pin configurations.

Consider for instance a relay with two switches, which can be designed as a symbol with three different units: a coil, switch 1, and switch 2. Designing a symbol with multiple units per package and/or alternate body styles is very flexible. A pin or a body symbol item can be common to all units or specific to a given unit or they can be common to both symbolic representation so are specific to a given symbol representation.

By default, pins are specific to a unit and body style. When a pin is common to all units or all body styles, it only needs to be created once. This is also the case for the body style graphic shapes and text, which may be
common to each unit, but typically are specific to each body style).

**Example of a Symbol With Multiple Noninterchangeable Units**

For an example of a symbol with multiple units that are not interchangeable, consider a relay with 3 units per package: a coil, switch 1, and switch 2.

The three units are not all the same, so "All units are interchangeable" should be deselected in the Symbol Properties dialog. Alternatively, this option could have been specified when the symbol was initially created.
Unit A does not have the same symbol and pin layout as Units B and C, so the units are not interchangeable.

**NOTE**

"Synchronized Pins Edit Mode" can be enabled by clicking the icon. In this mode, pin modifications are propagated between symbol units; changes made in one unit will be reflected in the other units as well. When this mode is disabled, pin changes made in one unit do not affect other units. This mode is enabled automatically when "All units are interchangeable" is checked, but it can be disabled. The mode cannot be enabled when "All units are interchangeable" is unchecked or when the symbol only has one unit.
Graphical Symbolic Elements

Shown below are properties for a graphic body element. In the relay example above, the three units have different symbolic representations. Therefore, each unit was created separately and the graphical body elements have the "Common to all units in symbol" setting disabled.

Pin Creation and Editing

You can click on the icon to create and insert a pin. The editing of all pin properties is done by double-clicking on the pin or right-clicking on the pin to open the pin context menu. Pins must be created carefully, because any error will have consequences on the PCB design. Any pin already placed can be edited, deleted, and/or moved.

Pin Overview

A pin is defined by its graphical representation, its name and its number. The pin's name and number can contain letters, numbers, and symbols, but not spaces. For the Electrical Rules Check (ERC) tool to be useful, the pin's electrical type (input, output, tri-state...) must also be defined correctly. If this type is not defined properly, the schematic ERC check results may be invalid.

Important notes:

- Symbol pins are matched to footprint pads by number. The pin number in the symbol must match the corresponding pad number in the footprint.
- Do not use spaces in pin names and numbers. Spaces will be automatically replaced with underscores (_).
- To define a pin name with an inverted signal (overline) use the ~ (tilde) character followed by the text to invert in braces. For example ~{FO}O would display FO O.
- If the pin name is empty, the pin is considered unnamed.
- Pin names can be repeated in a symbol.
Pin numbers must be unique in a symbol.

## Pin Properties

The pin properties dialog allows you to edit all of the characteristics of a pin. This dialog pops up automatically when you create a pin or when double-clicking on an existing pin. This dialog allows you to modify:

- The pin name and text size.
- The pin number and text size.
- The pin length.
- The pin electrical type and graphical style.
- Unit and alternate representation membership.
- Pin visibility.
- **Alternate pin definitions.**

### Pin Graphic Styles

Shown in the figure below are the different pin graphic styles. The choice of graphic style does not have any influence on the pin's electrical type.
Pin Electrical Types

Choosing the correct electrical type is important for the schematic ERC tool. ERC will check that pins are connected appropriately, for example ensuring that input pins are driven and power inputs receive power from an appropriate source.
<table>
<thead>
<tr>
<th>Pin Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>A pin which is exclusively an input.</td>
</tr>
<tr>
<td>Output</td>
<td>A pin which is exclusively an output.</td>
</tr>
<tr>
<td>Bidirectional</td>
<td>A pin that can be either an input or an output, such as a microcontroller data bus pin.</td>
</tr>
<tr>
<td>Tri-state</td>
<td>A three state output pin (high, low, or high impedance)</td>
</tr>
<tr>
<td>Passive</td>
<td>A passive symbol pin: resistors, connectors, etc.</td>
</tr>
<tr>
<td>Free</td>
<td>A pin that can be freely connected to any other pin without electrical concerns.</td>
</tr>
<tr>
<td>Unspecified</td>
<td>A pin for which the ERC check does not matter.</td>
</tr>
<tr>
<td>Power input</td>
<td>A symbol's power pin. As a special case, power input pins that are marked invisible are automatically connected to the net with the same name. See the Power Ports section for more information.</td>
</tr>
<tr>
<td>Power output</td>
<td>A pin that provides power to other pins, such as a regulator output.</td>
</tr>
<tr>
<td>Open collector</td>
<td>An open collector logic output.</td>
</tr>
<tr>
<td>Open emitter</td>
<td>An open emitter logic output.</td>
</tr>
<tr>
<td>Unconnected</td>
<td>A pin that should not be connected to anything.</td>
</tr>
</tbody>
</table>

**Pushing Pin Properties to Other Pins**

You can apply the length, name size, or number size of a pin to the other pins in the symbol by right clicking the pin and selecting Push Pin Length, Push Pin Name Size, or Push Pin Number Size, respectively.
Defining Pins for Multiple Units and Alternate Symbolic Representations

Symbols with multiple units and/or graphical representations are particularly problematic when creating and editing pins. The majority of pins are specific to each symbol unit (because each unit has a different set of pins) and to each body style (because the form and position is different between the normal body style and the alternate form).

The symbol library editor allows the simultaneous creation of pins. By default, changes made to a pin are made for all units of a multiple unit symbol and to both representations for symbols with an alternate symbolic representation. The only exception to this is the pin's graphical type and name, which remain unlinked between symbol units and body styles. This dependency was established to allow for easier pin creation and editing in most cases. This dependency can be disabled by toggling the icon on the main tool bar. This will allow you to create pins for each unit and representation completely independently.

Pins can be common or specific to different units. Pins can also be common to both symbolic representations or specific to each symbolic representation. When a pin is common to all units, it only has to drawn once. Pins are set as common or specific in the pin properties dialog.

An example is the output pin in the 7400 quad dual input NAND gate. Since there are four units and two symbolic representations, there are eight separate output pins defined in the symbol definition. When creating a new 7400 symbol, unit A of the normal symbolic representation will be shown in the library
editor. To edit the pin style in the alternate symbolic representation, it must first be enabled by clicking the \( \text{button on the tool bar. To edit the pin number for each unit, select the appropriate unit using the drop down control.} \)

**Pin Table**

Another way to edit pins is to use the Pin Table, which is accessible via the icon. The Pin Table displays all of the pins in the symbol and their properties in a table view, so it is useful for making bulk pin changes.

Any pin property can be edited by clicking on the appropriate cell. Pins can be added and removed with the and icons, respectively.

**NOTE** Columns of the pin table can be shown or hidden by right-clicking on the header row and checking or unchecking additional columns. Some columns are hidden by default.

The screenshot below shows the pin table for a quad opamp.

![Pin Table Screenshot](image)

**Alternate Pin Definitions**

Pins can have alternate pin definitions added to them. Alternate pin definitions allow a user to select a different name, electrical type, and graphical style for a pin when the symbol has been placed in the schematic. This can be used for pins that have multiple functions, such as microcontroller pins.

Alternate pin definitions are added in the Pin Properties dialog as shown below. Each alternate definition contains a pin name, electrical type, and graphic style. This microcontroller pin has all of its peripheral functions defined in the symbol as alternate pin names.
Alternate pin definitions are selected in the Schematic Editor once the symbol has been placed in the schematic. The alternate pin is assigned in the Alternate Pin Assignments tab of the Symbol Properties dialog. Alternate definitions are selectable in the dropdown in the Alternate Assignment column.
Symbol Fields

All library symbols are defined with four default fields. The reference designator, value, footprint assignment, and datasheet link fields are created whenever a symbol is created or copied. Only the reference designator and value fields are required.

Symbols defined in libraries are typically defined with only these four default fields. Additional fields such as vendor, part number, unit cost, etc. can be added to library symbols but generally this is done in the schematic editor so the additional fields can be applied to all of the symbols in the schematic.

NOTE

A convenient way to create additional empty symbol fields is to use define field name templates. Field name templates define empty fields that are added to each symbol when it is inserted into the schematic. Field name templates can be defined globally (for all schematics) in the Schematic Editor Preferences, or they can be defined locally (specific to each project) in the Schematic Setup dialog.

Editing Symbol Fields

To edit an existing symbol field, right-click on the field text to show the field context menu shown below.
To add new fields, delete optional fields, or edit existing fields, use the icon on the main tool bar to open the Symbol Properties dialog.

Fields are text information associated a the symbol. Do not confuse them with text in the graphic representation of a symbol.

Important notes:

- Modifying the Value field changes the name of the symbol. The symbol's name in the library will change when the symbol is saved.
- The Symbol Properties dialog must be used to edit a field that is empty or has the invisible attribute enabled because such fields cannot be clicked on.
- The footprint is defined as an absolute footprint using the LIBNAME:FOOTPRINTNAME format where LIBNAME is the name of the footprint library defined in the footprint library table (see the “Footprint Library Table” section in the PCB Editor manual) and FOOTPRINTNAME is the name of the footprint in the library LIBNAME.

**Creating Power Port Symbols**

Power ports, or power symbols, are symbols that are used to label a wire as part of a power net, like VCC or GND. The behavior of power ports is described in the electrical connections section. Power symbols are handled and created the same way as normal symbols, but there are several additional considerations described below.
It may be useful to place power symbols in a dedicated library. KiCad's symbol library places power symbols in the power library, and users may create libraries to store their own power symbols. If the "Define as power symbol" box is checked in a symbol's properties, that symbol will appear in the Schematic Editor's "Add Power Port" dialog for convenient access.

Below is an example of a GND power symbol.

Power port symbols consist of a pin of type "Power input" that is marked invisible. They must also have the "Define as power symbol" property checked. Invisible power input pins have a special property of making implicit global connections based on the pin name.

<table>
<thead>
<tr>
<th>Name</th>
<th>Unit</th>
<th>Body</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GND</td>
<td>A</td>
<td>Normal</td>
<td>Power Symbol</td>
<td>Power symbol creates a global label with name &quot;GND&quot;, ground</td>
</tr>
</tbody>
</table>

NOTE If the power symbol has the "Define as power symbol" property checked, the power input pin does not need to be marked invisible. However, the convention is to make these pins invisible anyway.
To create a power symbol, use the following steps:

- Add a pin of type "Power input", with "Visible" unchecked, and the pin named according to the desired net. Make the pin number 1, the length 0, and set the graphic style to "Line". The pin name establishes the connection to the net; in this case the pin will automatically connect to the net GND. The pin number, length, and line style do not matter electrically.

- Place the pin on the symbol anchor.

- Use the shape tools to draw the symbol graphics.

- Set the symbol value. The symbol value does not matter electrically, but it is displayed in the schematic. To eliminate confusion, it should match the pin name (which determines the connected net name).

- Check the "Define as power symbol" box in Symbol Properties window. This makes the symbol appear in the "Add Power Port" dialog, makes the Value field read-only in the schematic, prevents the symbol from being assigned a footprint, and excludes the symbol from the board, BOM, and netlists.

- Set the symbol reference and uncheck the "Show" box. The reference text is not important except for the first character, which should be #. For the power port shown above, the reference could be #GND. Symbols with references that begin with # are not added to the PCB, are not included in Bill of Materials exports or netlists, and they cannot be assigned a footprint in the footprint assignment tool. If a power port's reference does not begin with #, the character will be inserted automatically when the annotation or footprint assignment tools are run.

An easier method to create a new power port symbol is to use another symbol as a starting point, as described earlier.
The connected net name is determined by the power port's **pin name**, not the name or value of the symbol. When modifying an existing power port symbol, make sure to rename the pin so that the new symbol connects to the appropriate power net. This means that power port net names can only be changed in the symbol editor, not in the schematic.
Symbol Library Browser

Introduction

The Symbol Library Browser allows you to quickly examine the content of symbol libraries. The Symbol Library Viewer can be accessed by clicking icon on the main toolbar, View → Symbol Library Browser..., or clicking Select With Browser in the "Choose Symbol" window.

![Symbol Library Viewer](image)

**74LS02**
quad 2-input NOR gate
Key Words: TTL NorZ

<table>
<thead>
<tr>
<th>Reference</th>
<th>Value</th>
<th>Footprint</th>
</tr>
</thead>
<tbody>
<tr>
<td>U?A</td>
<td>74LS02</td>
<td></td>
</tr>
</tbody>
</table>

Datasheet: [http://www.ti.com/lit/gpn/sn74ls02](http://www.ti.com/lit/gpn/sn74ls02)
Viewlib - main screen

To examine the contents of a library, select a library from the list on the left hand pane. All symbols in the selected library will appear in the second pane. Select a symbol name to view the symbol.

Symbol Library Browser Top Toolbar

The top tool bar in Symbol Library Browser is shown below.

The available commands are:
<table>
<thead>
<tr>
<th></th>
<th>Selection of the symbol which can be also selected in the displayed list.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Display previous symbol.</td>
</tr>
<tr>
<td></td>
<td>Display next symbol.</td>
</tr>
<tr>
<td></td>
<td>Zoom tools.</td>
</tr>
<tr>
<td></td>
<td>Selection of the representation (normal or alternate) if an alternate representation exists.</td>
</tr>
<tr>
<td></td>
<td>Selection of the unit for symbols that contain multiple units.</td>
</tr>
<tr>
<td></td>
<td>If they exist, display the associated documents.</td>
</tr>
<tr>
<td></td>
<td>Close the browser and place the selected symbol in the schematic.</td>
</tr>
</tbody>
</table>
Simulator

KiCad provides an embedded electrical circuit simulator using ngspice as the simulation engine.

When working with the simulator, you may find the official pspice library useful. It contains common symbols used for simulation like voltage/current sources or transistors with pins numbered to match the ngspice node order specification.

There are also a few demo projects to illustrate the simulator capabilities. You will find them in demos/simulation directory.

Assigning models

Before a simulation is launched, components need to have Spice model assigned.

Each component can have only one model assigned, even if component consists of multiple units. In such case, the first unit should have the model specified.

Passive components with reference matching a device type in Spice notation (R* for resistors, C* for capacitors, L* for inductors) will have models assigned implicitly and use the value field to determine their properties.

NOTE

Keep in mind that in Spice notation 'M' stands for milli and 'Meg' corresponds to mega. If you prefer to use 'M' to indicate mega prefix, you may request doing so in the simulation settings dialog.

Spice model information is stored as text in symbol fields, therefore you may either define it in symbol editor or schematics editor. Open symbol properties dialog and click on Edit Spice Model button to open Spice Model Editor dialog.

Spice Model Editor dialog has three tabs corresponding to different model types. There are two options common to all model types:
<table>
<thead>
<tr>
<th>Disable symbol for simulation</th>
<th>When checked the component is excluded from simulation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternate node sequence</td>
<td>Allows one to override symbol pin to model node mapping. To define a different mapping, specify pin numbers in order expected by the model.</td>
</tr>
</tbody>
</table>

'Example:'

```
* connections:
  * 1: non-inverting input
  * 2: inverting input
  * 3: positive power supply
  * 4: negative power supply
  * 5: output
  .subckt tl071 1 2 3 4 5
```

To match the symbol pins to the Spice model nodes shown above, one needs to use an alternate node sequence option with value: "1 3 5 2 4". It is a list of pin numbers corresponding to the Spice model nodes order.

---

**Passive**

*Passive* tab allows the user to assign a passive device model (resistor, capacitor or inductor) to a component. It is a rarely used option, as normally passive components have models assigned implicitly, unless component reference does not match the actual device type.

---

**NOTE**

Explicitly defined passive device models have priority over the ones assigned implicitly. It means that once a passive device model is assigned, the reference and value fields are not taken into account during simulation. It may lead to a confusing situation when assigned model value does not match the one displayed on a schematic sheet.
**Spice Model Editor**

**Type:**
- Selects the device type (resistor, capacitor or inductor).

**Value:**
- Defines the device property (resistance, capacitance or inductance). The value may use common Spice unit prefixes (as listed below the text input field) and should use point as the decimal separator. Note that Spice does not correctly interpret prefixes intertwined in the value (e.g. 1k5).

**Spice unit symbols in values (case insensitive):**
- f (femto) $10^{-15}$
- p (pico) $10^{-12}$
- n (nano) $10^{-9}$
- u (micro) $10^{-6}$
- m (milli) $10^{-3}$
- k (kilo) $10^3$
- meg (mega) $10^6$
- g (giga) $10^9$
- t (tera) $10^{12}$

**Disable symbol for simulation**

**Alternate node sequence:**

---

<table>
<thead>
<tr>
<th><strong>Type</strong></th>
<th>Selects the device type (resistor, capacitor or inductor).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value</strong></td>
<td>Defines the device property (resistance, capacitance or inductance). The value may use common Spice unit prefixes (as listed below the text input field) and should use point as the decimal separator. Note that Spice does not correctly interpret prefixes intertwined in the value (e.g. 1k5).</td>
</tr>
</tbody>
</table>
Model

*Model tab is used to assign a semiconductor or a complex model defined in an external library file. Spice model libraries are often offered by device manufacturers.

The main text widget displays the selected library file contents. It is a common practice to put models description inside library files, including the node order.
File
Path to a Spice library file. This file is going to be used by the simulator, as it is added using `include` directive.

Model
Selected device model. When a file is selected, the list is filled with available models to choose from.

Type
Selects model type (subcircuit, BJT, MOSFET or diode). Normally it is set automatically when a model is selected.

Source
Source tab is used to assign a power or signal source model. There are two sections: DC/AC analysis and Transient analysis. Each defines source parameters for the corresponding simulation type.

Source type option applies to all simulation types.
Refer to the ngspace documentation, chapter 4 (Voltage and Current Sources) for more details about sources.

**Spice directives**

It is possible to add Spice directives by placing them in text fields on a schematic sheet. This approach is convenient for defining the default simulation type. This functionality is limited to Spice directives starting with a dot (e.g. \texttt{.tran 10n 1m}), it is not possible to place additional components using text fields.

**Simulation**

To launch a simulation, open \textit{Spice Simulator} dialog by selecting menu \textit{Tools → Simulator} in the schematics editor window.
The dialog is divided into several sections:

- Toolbar
- Plot panel
- Output console
- Signals list
- Cursors list
- Tune panel

Menu

File
<table>
<thead>
<tr>
<th>New Plot</th>
<th>Create a new tab in the plot panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Workbook</td>
<td>Open a list of plotted signals.</td>
</tr>
<tr>
<td>Save Workbook</td>
<td>Save a list of plotted signals.</td>
</tr>
<tr>
<td>Save as image</td>
<td>Export the active plot to a .png file.</td>
</tr>
<tr>
<td>Save as .csv file</td>
<td>Export the active plot raw data points to a .csv file.</td>
</tr>
<tr>
<td>Exit Simulation</td>
<td>Close the dialog.</td>
</tr>
</tbody>
</table>

**Simulation**

<table>
<thead>
<tr>
<th>Run Simulation</th>
<th>Perform a simulation using the current settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add signals...</td>
<td>Open a dialog to select signals to be plotted.</td>
</tr>
<tr>
<td>Probe from schematics</td>
<td>Start the schematics Probe tool.</td>
</tr>
<tr>
<td>Tune component value</td>
<td>Start the Tuner tool.</td>
</tr>
<tr>
<td>Show SPICE Netlist...</td>
<td>Open a dialog showing the generated netlist for the simulated circuit.</td>
</tr>
<tr>
<td>Settings...</td>
<td>Open the simulation settings dialog.</td>
</tr>
</tbody>
</table>

**View**

<table>
<thead>
<tr>
<th>Zoom In</th>
<th>Zoom in the active plot.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Out</td>
<td>Zoom out the active plot.</td>
</tr>
<tr>
<td>Fit on Screen</td>
<td>Adjust the zoom setting to display all plots.</td>
</tr>
<tr>
<td>Show grid</td>
<td>Toggle grid visibility.</td>
</tr>
<tr>
<td>Show legend</td>
<td>Toggle plot legend visibility.</td>
</tr>
</tbody>
</table>

**Toolbar**

- Run/Stop Simulation
- Add Signals
- Probe
- Tune
- Settings

The top toolbar provides access to the most frequently performed actions.
Run/Stop Simulation | Start or stop the simulation.
---|---
Add Signals | Open a dialog to select signals to be plotted.
Probe | Start the schematics Probe tool.
Tune | Start the Tuner tool.
Settings | Open the simulation settings dialog.

**Plot panel**
Visualizes the simulation results as plots. One can have multiple plots opened in separate tabs, but only the active one is updated when a simulation is executed. This way it is possible to compare simulation results for different runs.

Plots might be customized by toggling grid and legend visibility using View menu. When a legend is visible, it can be dragged to change its position.

Plot panel interaction:
- scroll mouse wheel to zoom in/out
- right click to open a context menu to adjust the view
- draw a selection rectangle to zoom in the selected area
- drag a cursor to change its coordinates

**Output console**
Output console displays messages from the simulator. It is advised to check the console output to verify there are no errors or warnings.

**Signals list**
Shows the list of signals displayed in the active plot.

Signals list interaction:
- right click to open a context menu to hide signal or toggle cursor
- double click to hide signal

**Cursors list**
Shows the list of cursors and their coordinates. Each signal may have one cursor displayed. Cursors visibility is set using the Signals list.

**Tune panel**
Displays components picked with the Tuner tool. Tune panel allows the user to quickly modify component values and observe their influence on the simulation results - every time a component value is changed, the simulation is rerun and plots are updated.

For each component there a few controls associated:
The top text field sets the maximum component value.

- The middle text field sets the actual component value.
- The bottom text field sets the minimum component value.
- Slider allows the user to modify the component value in a smooth way.
- Save button modifies component value on the schematics to the one selected with the slider.
- X button removes component from the Tune panel and restores its original value.

The three text fields recognize Spice unit prefixes.

**Tuner tool**

Tuner tool lets the user pick components for tuning.

To select a component for tuning, click on one in the schematics editor when the tool is active. Selected components will appear in the Tune panel. Only passive components might be tuned.

**Probe tool**

Probe tool provides an user-friendly way of selecting signals for plotting.

To add a signal to plot, click on a corresponding wire in the schematics editor when the tool is active.
Simulation settings

Simulation settings dialog lets the user set the simulation type and parameters. There are four tabs:

- AC
- DC Transfer
- Transient
- Custom

The first three tabs provide forms where simulation parameters might be specified. The last tab allows the user to type in custom Spice directives to set up a simulation. You can find more information about simulation types and parameters in the ngspice documentation, chapter 1.2.

An alternative way to configure a simulation is to type Spice directives into text fields on schematics. Any text field directives related to simulation type are overridden by the settings selected in the dialog. It means
that once you start using the simulation dialog, the dialog overrides the schematics directives until the simulator is reopened.

There are two options common to all simulation types:

<table>
<thead>
<tr>
<th>Adjust passive symbol values</th>
<th>Replace passive symbol values to convert common component values notation to Spice notation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add full path for .include library directives</td>
<td>Prepend Spice model library file names with full path. Normally full path is required by ngspice to access a library file.</td>
</tr>
</tbody>
</table>
Advanced Topics

Configuration and Customization

NOTE  TODO: write this section

Text variables

NOTE  TODO: write this section

Custom Netlist and BOM Formats

KiCad can output netlists and BOMs in various formats, and users can define new formats if desired.

The process of exporting a netlist is described in the netlist export section. BOM output is described in the BOM export section.

The following section describes how to create an exporter for a new output format.

Adding new netlist generators

New netlist generators are added to the Export Netlist dialog by clicking the Add Generator... button.

![Export Netlist dialog with Custom Netlist Generator added]

New generators require a name and a command. The name is shown in the tab label, and the command is run whenever the Export Netlist button is clicked.

When the netlist is generated, KiCad creates an intermediate XML file which contains all of the netlist information from the schematic. The generator command is then run in order to transform the intermediate netlist into the desired netlist format.

The netlist command must be set up properly so that the netlist generator script takes the intermediate netlist file as input and outputs the desired netlist file. The exact netlist command will depend on the generator script used. The command format is described below.

Python and XSLT are commonly used tools to create custom netlist generators.
Adding a new BOM generator

KiCad also uses the intermediate netlist file to generate BOMs with the Generate BOM tool.

Additional scripts can be added to the list of BOM generator scripts by clicking the button. Scripts can be removed by clicking the button. The button opens the selected script in a text editor.

Generator scripts written in Python and XSLT can contain a header comment that describes the generator's functionality and usage. This header comment is displayed in the BOM dialog as the description for each generator. The header comment must contain the string `@package`. Everything following that string until the end of the comment is used as the description for the generator.

KiCad automatically fills the command line field when a new generator script is added, but the command line might need to be adjusted by hand depending on the generator script. KiCad attempts to automatically determine the output file extension from the example command line in the generator script's header.

Generator command line format

The command line for a netlist or BOM exporter defines the command that KiCad will run to generate the selected output file.

For a netlist exporter using `xsltproc`, an example is:

```
xsltproc -o %O.net /usr/share/kicad/plugins/netlist_form_pads-pcb.asc.xsl %I
```

For a BOM exporter using Python, an example is:

```
/usr/bin/python3 /usr/share/kicad/plugins/bom_csv_grouped_by_value.py "%I" "%O.csv"
```

**NOTE**  It is recommended to surround arguments in the command line with quotes (") in case they contain spaces or other special characters.
Some character sequences like %I and %O have a special meaning in the command line, because KiCad replaces them with a filename or path before executing the command.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Replaced with...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%I</td>
<td><code>&lt;project path&gt;/project name&gt;.xml</code></td>
<td>Absolute path and filename of the intermediate netlist file, which is the input to the BOM or netlist generator plugin</td>
</tr>
<tr>
<td>%O</td>
<td><code>&lt;project path&gt;/project name&gt;</code></td>
<td>Absolute path and filename of the output BOM or netlist file (without file extension). An appropriate file extension may need to be specified after the %O sequence.</td>
</tr>
<tr>
<td>%B</td>
<td><code>&lt;project name&gt;</code></td>
<td>Base filename of the output BOM or netlist file (without path or file extension). An appropriate file extension may need to be specified after the %B sequence.</td>
</tr>
<tr>
<td>%P</td>
<td><code>&lt;project path&gt;</code></td>
<td>Absolute path of the project directory, without trailing slash.</td>
</tr>
</tbody>
</table>

**Intermediate Netlist File**

When exporting BOM files and netlists, KiCad creates an intermediate netlist file and then runs a separate tool which post-processes the intermediate netlist into the desired netlist or BOM format.

The intermediate netlist uses XML syntax. It contains a large amount of data about the design. Depending on the output (BOM or netlist), different subsets of the complete intermediate netlist file will be included in the final output file.

The structure of the intermediate netlist file is described in detail below.

Because the conversion from intermediate netlist file to output netlist or BOM is a text-to-text transformation, the post-processing filter can be written using Python, XSLT, or any other tool capable of taking XML as input.

**NOTE**

XSLT is not recommended for new netlist or BOM exporters; Python or another tool should be used instead. Beginning with KiCad 7, `xsltproc` is no longer installed with KiCad, although it can be installed separately. Nevertheless, several examples of netlist exporters using XSLT are included below.

**Intermediate Netlist structure**

This sample gives an idea of the netlist file format.
<?xml version="1.0" encoding="utf-8"?>
<export version="D">
<design>
<source>F:\kicad\netlist_test\netlist_test.sch</source>
<date>29/08/2010 21:07:51</date>
<tool>eeschema (2010-08-28 BZR 2458)-unstable</tool>
</design>
<components>
<comp ref="P1">
  <value>CONN_4</value>
  <libsource lib="conn" part="CONN_4"/>
  <sheetpath names="/" tstamps="/"/>
  <tstamps>4C6E2141</tstamps>
</comp>
<comp ref="U2">
  <value>74LS74</value>
  <libsource lib="74xx" part="74LS74"/>
  <sheetpath names="/" tstamps="/"/>
  <tstamps>4C6E20BA</tstamps>
</comp>
<comp ref="U1">
  <value>74LS04</value>
  <libsource lib="74xx" part="74LS04"/>
  <sheetpath names="/" tstamps="/"/>
  <tstamps>4C6E20A6</tstamps>
</comp>
<comp ref="C1">
  <value>CP</value>
  <libsource lib="device" part="CP"/>
  <sheetpath names="/" tstamps="/"/>
  <tstamps>4C6E2094</tstamps>
</comp>
<comp ref="R1">
  <value>R</value>
  <libsource lib="device" part="R"/>
  <sheetpath names="/" tstamps="/"/>
  <tstamps>4C6E208A</tstamps>
</comp>
</components>
<libparts/>
<libraries/>
<nets>
<nets>
<net code="1" name="GND">
  <node ref="U1" pin="7"/>
  <node ref="C1" pin="2"/>
  <node ref="U2" pin="7"/>
  <node ref="P1" pin="4"/>
</nets>
<nets>
<net code="2" name="VCC">
  <node ref="R1" pin="1"/>
  <node ref="U1" pin="14"/>
  <node ref="U2" pin="4"/>
  <node ref="U2" pin="1"/>
  <node ref="U2" pin="14"/>
  <node ref="P1" pin="1"/>
</nets>
<nets>
<net code="3" name="">
  <node ref="U2" pin="6"/>
</nets>
<nets>
<net code="4" name="">
  <node ref="U1" pin="2"/>
  <node ref="U2" pin="3"/>
</nets>
General netlist file structure
The intermediate Netlist accounts for five sections.

- The header section.
- The components section.
- The lib parts section.
- The libraries section.
- The nets section.

The file content has the delimiter `<export>`

```xml
<export version="D">
  ...
</export>
```

The header section
The header has the delimiter `<design>`

```xml
<design>
  <source>F:\kicad_aux\netlist_test\netlist_test.sch</source>
  <date>21/08/2010 08:12:08</date>
  <tool>eeschema (2010-08-09 BZR 2439)-unstable</tool>
</design>
```

This section can be considered a comment section.

The components section
The component section has the delimiter `<components>`

```xml
<components>
  <comp ref="P1">
    <value>CONN_4</value>
    <libsource lib="conn" part="CONN_4"/>
    <sheetpath names="/" tstamps="/"/>
    <tstamps>4C6E2141</tstamps>
  </comp>
</components>
```

This section contains the list of components in your schematic. Each component is described like this:
Note about time stamps for components

To identify a component in a netlist and therefore on a board, the timestamp reference is used as unique for each component. However KiCad provides an auxiliary way to identify a component which is the corresponding footprint on the board. This allows the re-annotation of components in a schematic project and does not lose the link between the component and its footprint.

A time stamp is an unique identifier for each component or sheet in a schematic project. However, in complex hierarchies, the same sheet is used more than once, so this sheet contains components having the same time stamp.

A given sheet inside a complex hierarchy has an unique identifier: its sheetpath. A given component (inside a complex hierarchy) has a unique identifier: the sheetpath and its timestamp.

The libparts section

The libparts section has the delimiter `<libparts>`, and the content of this section is defined in the schematic libraries.
<libparts>
  <libpart lib="device" part="CP">
    <description>Condensateur polarisé</description>
    <footprints>
      <fp>CP*</fp>
      <fp>SM*</fp>
    </footprints>
    <fields>
      <field name="Reference">C</field>
      <field name="Valeur">CP</field>
    </fields>
    <pins>
      <pin num="1" name="1" type="passive"/>
      <pin num="2" name="2" type="passive"/>
    </pins>
  </libpart>
</libparts>

<table>
<thead>
<tr>
<th>Element name</th>
<th>Element description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;footprints&gt;</td>
<td>The symbol's footprint filters. Each footprint filter is in a separate &lt;fp&gt; tag.</td>
</tr>
<tr>
<td>&lt;fields&gt;</td>
<td>The symbol's fields. Each field's name and value is given in a separate <code>&lt;field name=&quot;fieldname&quot;&gt;...&lt;/field&gt;</code> tag.</td>
</tr>
<tr>
<td>&lt;pins&gt;</td>
<td>The symbol's pins. Each pin is given in a separate <code>&lt;pin num=&quot;pinnum&quot; type=&quot;pintype&quot;&gt;...&lt;/pin&gt;</code> tag. Possible pintypes are described below.</td>
</tr>
</tbody>
</table>

Possible electrical pin types are:
<table>
<thead>
<tr>
<th>Pintype</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Usual input pin</td>
</tr>
<tr>
<td>Output</td>
<td>Usual output</td>
</tr>
<tr>
<td>Bidirectional</td>
<td>Input or Output</td>
</tr>
<tr>
<td>Tri-state</td>
<td>Bus input/output</td>
</tr>
<tr>
<td>Passive</td>
<td>Usual ends of passive components</td>
</tr>
<tr>
<td>Unspecified</td>
<td>Unknown electrical type</td>
</tr>
<tr>
<td>Power input</td>
<td>Power input of a component</td>
</tr>
<tr>
<td>Power output</td>
<td>Power output like a regulator output</td>
</tr>
<tr>
<td>Open collector</td>
<td>Open collector often found in analog comparators</td>
</tr>
<tr>
<td>Open emitter</td>
<td>Open emitter sometimes found in logic</td>
</tr>
<tr>
<td>Not connected</td>
<td>Must be left open in schematic</td>
</tr>
</tbody>
</table>

**The libraries section**

The libraries section has the delimiter `<libraries>`. This section contains the list of schematic libraries used in the project.

```xml
<libraries>
  <library logical="device">
    <uri>F:\kicad\share\library\device.lib</uri>
  </library>
  <library logical="conn">
    <uri>F:\kicad\share\library\conn.lib</uri>
  </library>
</libraries>
```

**The nets section**

The nets section has the delimiter `<nets>`. This section describes the connectivity of the schematic by listing all nets and the pins connected to each net.
A possible net contains the following.

<table>
<thead>
<tr>
<th>Element name</th>
<th>Element Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>net code</td>
<td>an internal identifier for this net</td>
</tr>
<tr>
<td>name</td>
<td>the net name</td>
</tr>
<tr>
<td>node</td>
<td>the pin (identified by pin) of a symbol (identified by ref) which is connected to the net</td>
</tr>
</tbody>
</table>

**Example netlist exporters**

Some example netlist exporters using XSLT are included below.

XSLT itself is an XML language very suitable for XML transformations. The `xsltproc` program can be used to read the Intermediate XML netlist input file, apply a style-sheet to transform the input, and save the results in an output file. Use of `xsltproc` requires a style-sheet file using XSLT conventions. The full conversion process is handled by KiCad, after it is configured once to run `xsltproc` in a specific way.

The document that describes XSL Transformations (XSLT) is available here: [http://www.w3.org/TR/xslt](http://www.w3.org/TR/xslt)

**NOTE** When writing a new netlist exporter, consider using Python or another tool rather than XSLT.
PADS netlist example using XSLT

The following example shows how to create an exporter for the PADS netlist format using `xsltproc`.

The PADS netlist format is comprised of two sections:

- A list of footprints
- A list of nets, together with the pads connected to each net.

Below is an XSL style-sheet which converts the intermediate netlist file to the PADS netlist format.
<?xml version="1.0" encoding="ISO-8859-1"?>
<!--XSL style sheet to Eeschema Generic Netlist Format to PADS netlist format
Copyright (C) 2010, SoftPLC Corporation.
GPL v2.
How to use:
https://lists.launchpad.net/kicad-developers/msg05157.html
-->
<!DOCTYPE xsl:stylesheet [
  <!ENTITY nl  "&#xd;&#xa;" --> <!--new line CR, LF -->
]>}

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
  <xsl:output method="text" omit-xml-declaration="yes" indent="no"/>
  <xsl:template match="/export">
    <xsl:text>*PADS-PCB*&nl;*PART*&nl;</xsl:text>
    <xsl:apply-templates select="components/comp"/>
    <xsl:text>*NET*&nl;</xsl:text>
    <xsl:apply-templates select="nets/net"/>
    <xsl:text>*END*&nl;</xsl:text>
  </xsl:template>

  <!-- for each component -->
  <xsl:template match="comp">
    <xsl:text> </xsl:text>
    <xsl:value-of select="@ref"/>
    <xsl:text> </xsl:text>
    <xsl:choose>
      <xsl:when test = "footprint != '' ">
        <xsl:apply-templates select="footprint"/>
      </xsl:when>
      <xsl:otherwise>
        unknown
      </xsl:otherwise>
    </xsl:choose>
    <xsl:text>&nl;</xsl:text>
  </xsl:template>

  <!-- for each net -->
  <xsl:template match="net">
    <!-- nets are output only if there is more than one pin in net -->
    <xsl:if test="count(node)>1">
      <xsl:text>*SIGNAL* </xsl:text>
      <xsl:choose>
        <xsl:when test = "@name != '' ">
          <xsl:value-of select="@name"/>
        </xsl:when>
        <xsl:otherwise>
          N-<xsl:value-of select="@code"/>
        </xsl:otherwise>
      </xsl:choose>
      <xsl:text>&nl;</xsl:text>
      <xsl:apply-templates select="node"/>
    </xsl:if>
  </xsl:template>

  <!-- for each node -->
  <xsl:template match="node">
    <xsl:text> </xsl:text>
  </xsl:template>
</xsl:stylesheet>
And here is the PADS netlist output file after running `xsltproc`:

```plaintext
*PADS-PCB*
*PART*
P1 unknown
U2 unknown
U1 unknown
C1 unknown
R1 unknown
*NET*
*SIGNAL* GND
U1.7
C1.2
U2.7
P1.4
*SIGNAL* VCC
R1.1
U1.14
U2.4
U2.1
U2.14
P1.1
*SIGNAL* N-4
U1.2
U2.3
*SIGNAL* /SIG_OUT
P1.2
U2.5
U2.2
*SIGNAL* /CLOCK_IN
R1.2
C1.1
U1.1
P1.3
*END*
```

The command line to make this conversion is:

```
kicad\bin\xsltproc.exe -o test.net kicad\bin\plugins\netlist_form_pads-pcb.xsl test.tmp
```

**Cadstar netlist example using XSLT**

The following example shows how to create an exporter for the Cadstar netlist format using `xsltproc`.

The Cadstar format is comprised of two sections:

- The footprint list
- The Nets list: grouping pads references by nets

Below is an XSL style-sheet which converts the intermediate netlist file to the Cadstar netlist format.
<?xml version="1.0" encoding="ISO-8859-1"?>
<!--XSL style sheet to Eeschema Generic Netlist Format to CADSTAR netlist format
Copyright (C) 2010, Jean-Pierre Charras.
Copyright (C) 2010, SoftPLC Corporation.
GPL v2. -->

<!DOCTYPE xsl:stylesheet [
  <!ENTITY nl  "&#xd;&#xa;" --> <!--new line CR, LF -->
]></xsl:stylesheet

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
  <xsl:output method="text" omit-xml-declaration="yes" indent="no"/>

  <!-- Netlist header -->
  <xsl:template match="/export">
    <xsl:text>.HEA</xsl:text>
    <xsl:text>nl;</xsl:text>
    <xsl:apply-templates select="design/date"/>  <!-- Generate line .TIM <time> -->
    <xsl:apply-templates select="design/tool"/>  <!-- Generate line .APP <eeschema version> -->
    <xsl:apply-templates select="components/comp"/>  <!-- Generate list of components -->
    <xsl:text>nl;</xsl:text>
    <xsl:apply-templates select="nets/net"/>          <!-- Generate list of nets and connections -->
    <xsl:text>nl;END</xsl:text>
  </xsl:template>

  <!-- Generate line .TIM 20/08/2010 10:45:33 -->
  <xsl:template match="tool">
    <xsl:text>.APP "</xsl:text>
    <xsl:apply-templates/>
    <xsl:text>"nl;nl;</xsl:text>
  </xsl:template>

  <!-- Generate line .APP "eeschema (2010-08-17 BZR 2450)-unstable" -->
  <xsl:template match="date">
    <xsl:text>.TIM </xsl:text>
    <xsl:apply-templates/>
    <xsl:text>nl;</xsl:text>
  </xsl:template>

  <!-- for each component -->
  <xsl:template match="comp">
    <xsl:text>.ADD_COM </xsl:text>
    <xsl:value-of select="@ref"/>
    <xsl:text>nl;</xsl:text>
    <xsl:choose>
      <xsl:when test="value != ' ' ">
        <xsl:text>"</xsl:text>
        <xsl:apply-templates select="value"/>
        <xsl:text>"</xsl:text>
      </xsl:when>
      <xsl:otherwise>
        <xsl:text>""</xsl:text>
      </xsl:otherwise>
    </xsl:choose>
  </xsl:template>

  <!-- for each net -->
  <xsl:template match="net">
    <!-- nets are output only if there is more than one pin in net -->
    <xsl:if test="count(node)>1"/>
    <xsl:variable name="netname"/>
Here is the Cadstar output file.

```
.HEA
.TIM 21/08/2010 08:12:08
.APP "eeschema (2010-08-09 BZR 2439)-unstable"
.ADD_COM P1 "CONN_4"
.ADD_COM U2 "74LS74"
.ADD_COM U1 "74LS04"
.ADD_COM C1 "CP"
.ADD_COM R1 "R"

.ADD_TER U1.7 "GND"
.TER     C1.2
         U2.7
         P1.4

.ADD_TER R1.1 "VCC"
.TER     U1.14
         U2.4
         U2.1
         U2.14
         P1.1

.ADD_TER U1.2 "N-4"
.TER     U2.3

.ADD_TER P1.2 "/SIG_OUT"
.TER     U2.5
         U2.2

.ADD_TER R1.2 "/CLOCK_IN"
.TER     C1.1
         U1.1
         P1.3

.END
```

**OrcadPCB2 netlist example using XSLT**

This format has only one section which is the footprint list. Each footprint includes a list of its pads with reference to a net.

Below is an XSL style-sheet which converts the intermediate netlist file to the Orcad netlist format.
<?xml version="1.0" encoding="ISO-8859-1"?>
<!--XSL style sheet to Eeschema Generic Netlist Format to CADSTAR netlist format
Copyright (C) 2010, SoftPLC Corporation.
GPL v2.

How to use:
https://lists.launchpad.net/kicad-developers/msg05157.html
-->}
<!DOCTYPE xsl:stylesheet [ 
  <!ENTITY nl  "&xd;&#xa;" > <!--new line CR, LF --> ]>
xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
xsl:output method="text" omit-xml-declaration="yes" indent="no"/>

<!--
Netlist header
Creates the entire netlist
(can be seen as equivalent to main function in C
-->}
xsl:template match="/export">
xsl:text>( { Eeschema Netlist Version 1.1  </xsl:text>
<!-- Generate line .TIM <time> -->
xsl:apply-templates select="design/date"/>
<!-- Generate line eeschema version ... -->
xsl:apply-templates select="design/tool"/>
xsl:text>}&nl;)
xsl:text>

<!-- Generate the list of components -->
xsl:apply-templates select="components/comp"/>

<!-- end of file -->
xsl:text}&nl;*&nl;</xsl:text>
</xsl:template>

<!--
Generate id in header like "eeschema (2010-08-17 BZR 2450)-unstable"
-->}
xsl:template match="tool">
xsl:apply-templates/>
</xsl:template>

<!--
Generate date in header like "20/08/2010 10:45:33"
-->}
xsl:template match="date">
xsl:apply-templates/>
<xsl:text>&nl;</xsl:text>
</xsl:template>

<!--
This template read each component
(path = /export/components/comp)
creates lines:
( 3EBF7D8D $noname U1 74LS125
 ... pin list ...
 )
and calls "create_pin_list" template to build the pin list
-->}
xsl:template match="comp">
xsl:text>( </xsl:text>
Here is the OrcadPCB2 output file.

```plaintext
( { Eeschema Netlist Version 1.1  29/08/2010 21:07:51
  eeschema (2010-08-28 BZR 2458)-unstable}
  ( 4C6E2141 $noname P1 CONN_4
    ( 1 VCC )
    ( 2 /SIG_OUT )
    ( 3 /CLOCK_IN )
    ( 4 GND )
  )
  ( 4C6E20BA $noname U2 74LS74
    ( 1 VCC )
    ( 2 /SIG_OUT )
    ( 3 N-04 )
    ( 4 VCC )
    ( 5 /SIG_OUT )
    ( 6 ? )
    ( 7 GND )
    ( 14 VCC )
  )
  ( 4C6E20A6 $noname U1 74LS04
    ( 1 /CLOCK_IN )
    ( 2 N-04 )
    ( 7 GND )
    ( 14 VCC )
  )
  ( 4C6E2094 $noname C1 CP
    ( 1 /CLOCK_IN )
    ( 2 GND )
  )
  ( 4C6E208A $noname R1 R
    ( 1 VCC )
    ( 2 /CLOCK_IN )
  )
)
*
```
# Actions reference

Below is a list of every available action in the KiCad Schematic Editor: a command that can be assigned to a hotkey.

## Schematic Editor

The actions below are available in the Schematic Editor. Hotkeys can be assigned to any of these actions in the **Hotkeys** section of the preferences.

<table>
<thead>
<tr>
<th>Action</th>
<th>Default Hotkey</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Elements to Grid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Annotate Schematic...</td>
<td></td>
<td>Fill in schematic symbol reference designators</td>
</tr>
<tr>
<td>Assign Footprints...</td>
<td></td>
<td>Run footprint assignment tool</td>
</tr>
<tr>
<td>Clear Net Highlighting</td>
<td></td>
<td>Clear any existing net highlighting</td>
</tr>
<tr>
<td>Export Drawing to Clipboard</td>
<td></td>
<td>Export drawing of current sheet to clipboard</td>
</tr>
<tr>
<td>Edit Library Symbol...</td>
<td>Ctrl + Shift + E</td>
<td>Open the library symbol in the Symbol Editor</td>
</tr>
<tr>
<td>Edit Sheet Page Number...</td>
<td></td>
<td>Edit the page number of the current or selected sheet</td>
</tr>
<tr>
<td>Edit Symbol Fields...</td>
<td></td>
<td>Bulk-edit fields of all symbols in schematic</td>
</tr>
<tr>
<td>Edit Symbol Library Links...</td>
<td></td>
<td>Edit links between schematic and library symbols</td>
</tr>
<tr>
<td>Edit with Symbol Editor</td>
<td>Ctrl + E</td>
<td>Open the selected symbol in the Symbol Editor</td>
</tr>
<tr>
<td>Highlight on PCB</td>
<td></td>
<td>Highlight corresponding items in PCB editor</td>
</tr>
<tr>
<td>Export Netlist...</td>
<td></td>
<td>Export file containing netlist in one of several formats</td>
</tr>
<tr>
<td>Force H/V Wires and Buses</td>
<td></td>
<td>Switch H &amp; V only mode for new wires and buses</td>
</tr>
<tr>
<td>Generate BOM...</td>
<td></td>
<td>Generate a bill of materials for the current schematic</td>
</tr>
<tr>
<td>Highlight Net</td>
<td></td>
<td>Highlight net under cursor</td>
</tr>
<tr>
<td>Action</td>
<td>Default Hotkey</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Highlight Nets</td>
<td></td>
<td>Highlight wires and pins of a net</td>
</tr>
<tr>
<td>Import Footprint</td>
<td></td>
<td>Import symbol footprint assignments from .cmp file created by Pcbnew</td>
</tr>
<tr>
<td>Assignments...</td>
<td></td>
<td>Remap library symbol references in legacy schematics to the symbol library table</td>
</tr>
<tr>
<td>Remap Legacy Library Symbols...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Repair Schematic</td>
<td></td>
<td>Run various diagnostics and attempt to repair schematic</td>
</tr>
<tr>
<td>Rescue Symbols...</td>
<td></td>
<td>Find old symbols in project and rename/rescue them</td>
</tr>
<tr>
<td>Simulator...</td>
<td></td>
<td>Simulate circuit in SPICE</td>
</tr>
<tr>
<td>Save Current Sheet Copy As...</td>
<td></td>
<td>Save a copy of the current sheet to another location or name</td>
</tr>
<tr>
<td>Schematic Setup...</td>
<td></td>
<td>Edit schematic setup including annotation styles and electrical rules</td>
</tr>
<tr>
<td>Bus Definitions...</td>
<td></td>
<td>Manage bus definitions</td>
</tr>
<tr>
<td>Show Hidden Fields</td>
<td></td>
<td>Toggle display of hidden text fields</td>
</tr>
<tr>
<td>Show Hidden Pins</td>
<td></td>
<td>Toggle display of hidden pins</td>
</tr>
<tr>
<td>Switch to PCB Editor</td>
<td></td>
<td>Open PCB in board editor</td>
</tr>
<tr>
<td>Scripting Console</td>
<td></td>
<td>Show the Python scripting console</td>
</tr>
<tr>
<td>Symbol Checker</td>
<td></td>
<td>Show the symbol checker window</td>
</tr>
<tr>
<td>Electrical Rules Checker</td>
<td></td>
<td>Perform electrical rules check</td>
</tr>
<tr>
<td>Show Datasheet</td>
<td><code>D</code></td>
<td>Opens the datasheet in a browser</td>
</tr>
<tr>
<td>Add Sheet</td>
<td><code>S</code></td>
<td>Add a hierarchical sheet</td>
</tr>
<tr>
<td>Finish Sheet</td>
<td></td>
<td>Finish drawing sheet</td>
</tr>
<tr>
<td>Import Sheet Pin</td>
<td></td>
<td>Import a hierarchical sheet</td>
</tr>
<tr>
<td>Import Sheet Pin</td>
<td></td>
<td>Import a hierarchical sheet</td>
</tr>
<tr>
<td>Add Wire to Bus Entry</td>
<td><code>Z</code></td>
<td>Add a wire entry to a bus</td>
</tr>
<tr>
<td>Add Global Label</td>
<td><code>Ctrl + L</code></td>
<td>Add a global label</td>
</tr>
<tr>
<td>Action</td>
<td>Default Hotkey</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Add No Connect Flag</td>
<td>Q</td>
<td>Add a no-connection flag</td>
</tr>
<tr>
<td>Add Power</td>
<td>P</td>
<td>Add a power port</td>
</tr>
<tr>
<td>Add Text</td>
<td>T</td>
<td>Add text</td>
</tr>
<tr>
<td>Add Symbol</td>
<td>A</td>
<td>Add a symbol</td>
</tr>
<tr>
<td>Add Junctions to Selection where needed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Bus</td>
<td>B</td>
<td>Add a bus</td>
</tr>
<tr>
<td>Add Lines</td>
<td>I</td>
<td>Add connected graphic lines</td>
</tr>
<tr>
<td>Add Wire</td>
<td>W</td>
<td>Add a wire</td>
</tr>
<tr>
<td>Finish Wire or Bus</td>
<td>K</td>
<td>Complete drawing at current segment</td>
</tr>
<tr>
<td>Finish Bus</td>
<td></td>
<td>Complete bus with current segment</td>
</tr>
<tr>
<td>Finish Lines</td>
<td></td>
<td>Complete connected lines with current segment</td>
</tr>
<tr>
<td>Finish Wire</td>
<td></td>
<td>Complete wire with current segment</td>
</tr>
<tr>
<td>Unfold from Bus</td>
<td>C</td>
<td>Break a wire out of a bus</td>
</tr>
<tr>
<td>Assign Netclass...</td>
<td></td>
<td>Assign a netclass to the net of the selected wire</td>
</tr>
<tr>
<td>Autoplace Fields</td>
<td>D</td>
<td>Runs the automatic placement algorithm on the symbol or sheet’s fields</td>
</tr>
<tr>
<td>Break Bus</td>
<td></td>
<td>Divide a bus into segments which can be dragged independently</td>
</tr>
<tr>
<td>Break Wire</td>
<td></td>
<td>Divide a wire into segments which can be dragged independently</td>
</tr>
<tr>
<td>Change Symbol...</td>
<td></td>
<td>Assign a different symbol from the library</td>
</tr>
<tr>
<td>Change Symbols...</td>
<td></td>
<td>Assign different symbols from the library</td>
</tr>
<tr>
<td>Cleanup Sheet Pins</td>
<td></td>
<td>Delete unreferenced sheet pins</td>
</tr>
<tr>
<td>Edit Footprint...</td>
<td>E</td>
<td>Displays footprint field dialog</td>
</tr>
<tr>
<td>Edit Reference Designator...</td>
<td>U</td>
<td>Displays reference designator dialog</td>
</tr>
<tr>
<td>Edit Text &amp; Graphics Properties...</td>
<td></td>
<td>Edit text and graphics properties globally across schematic</td>
</tr>
<tr>
<td>Action</td>
<td>Default Hotkey</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pin Table…</td>
<td></td>
<td>Displays pin table for bulk editing of pins</td>
</tr>
<tr>
<td>Properties…</td>
<td>E</td>
<td>Displays item properties dialog</td>
</tr>
<tr>
<td>Repeat Last Item</td>
<td>Ins</td>
<td>Duplicates the last drawn item</td>
</tr>
<tr>
<td>Rotate Counterclockwise</td>
<td>R</td>
<td>Rotates selected item(s) counter-clockwise</td>
</tr>
<tr>
<td>Rotate Clockwise</td>
<td></td>
<td>Rotates selected item(s) clockwise</td>
</tr>
<tr>
<td>De Morgan Alternate</td>
<td></td>
<td>Switch to alternate De Morgan representation</td>
</tr>
<tr>
<td>De Morgan Standard</td>
<td></td>
<td>Switch to standard De Morgan representation</td>
</tr>
<tr>
<td>Symbol Properties…</td>
<td></td>
<td>Displays symbol properties dialog</td>
</tr>
<tr>
<td>Change to Global Label</td>
<td></td>
<td>Change existing item to a global label</td>
</tr>
<tr>
<td>Change to Hierarchical Label</td>
<td></td>
<td>Change existing item to a hierarchical label</td>
</tr>
<tr>
<td>Change to Label</td>
<td></td>
<td>Change existing item to a label</td>
</tr>
<tr>
<td>Change to Text</td>
<td></td>
<td>Change existing item to a text comment</td>
</tr>
<tr>
<td>De Morgan Conversion</td>
<td></td>
<td>Switch between De Morgan representations</td>
</tr>
<tr>
<td>Update Symbol…</td>
<td></td>
<td>Update symbol to include any changes from the library</td>
</tr>
<tr>
<td>Update Symbols from Library</td>
<td></td>
<td>Update symbols to include any changes from the library</td>
</tr>
<tr>
<td>Move Activate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drag</td>
<td>G</td>
<td>Drags the selected item(s)</td>
</tr>
<tr>
<td>Move</td>
<td>M</td>
<td>Moves the selected item(s)</td>
</tr>
<tr>
<td>Select Connection</td>
<td>Alt + 4</td>
<td>Select a complete connection</td>
</tr>
<tr>
<td>Select Node</td>
<td>Alt + 3</td>
<td>Select a connection item under the cursor</td>
</tr>
<tr>
<td>Enter Sheet</td>
<td></td>
<td>Display the selected sheet's contents in the schematic editor</td>
</tr>
<tr>
<td>Navigate to page</td>
<td></td>
<td>Navigate to page</td>
</tr>
<tr>
<td>Action</td>
<td>Default Hotkey</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Corner</td>
<td></td>
<td>Create a corner</td>
</tr>
<tr>
<td>Remove Corner</td>
<td></td>
<td>Remove corner</td>
</tr>
<tr>
<td>Add a simulator probe</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select a value to be tuned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Arc</td>
<td></td>
<td>Add an arc</td>
</tr>
<tr>
<td>Add Circle</td>
<td></td>
<td>Add a circle</td>
</tr>
<tr>
<td>Add Lines</td>
<td></td>
<td>Add connected graphic lines</td>
</tr>
<tr>
<td>Add Rectangle</td>
<td></td>
<td>Add a rectangle</td>
</tr>
<tr>
<td>Finish Drawing</td>
<td></td>
<td>Finish drawing shape</td>
</tr>
<tr>
<td>Move Symbol Anchor</td>
<td></td>
<td>Specify a new location for the symbol anchor</td>
</tr>
<tr>
<td>Add Pin</td>
<td>P</td>
<td>Add a pin</td>
</tr>
<tr>
<td>Add Text</td>
<td></td>
<td>Add a text item</td>
</tr>
<tr>
<td>Add Symbol to Schematic</td>
<td></td>
<td>Add Symbol to Schematic</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Symbol</td>
<td></td>
<td>Remove the selected symbol from its library</td>
</tr>
<tr>
<td>Duplicate Symbol</td>
<td></td>
<td>Make a copy of the selected symbol</td>
</tr>
<tr>
<td>Edit Symbol</td>
<td></td>
<td>Show selected symbol on editor canvas</td>
</tr>
<tr>
<td>Export...</td>
<td></td>
<td>Export a symbol to a new library file</td>
</tr>
<tr>
<td>Export Symbol as SVG...</td>
<td></td>
<td>Create SVG file from the current symbol</td>
</tr>
</tbody>
</table>
## Action

<table>
<thead>
<tr>
<th>Action</th>
<th>Default Hotkey</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export View as PNG...</td>
<td></td>
<td>Create PNG file from the current view</td>
</tr>
<tr>
<td>Hide Symbol Tree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Symbol...</td>
<td></td>
<td>Import a symbol to the current library</td>
</tr>
<tr>
<td>New Symbol...</td>
<td>N</td>
<td>Create a new symbol</td>
</tr>
<tr>
<td>Paste Symbol</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Library As...</td>
<td>Ctrl + Shift +</td>
<td>Save the current library to a new file.</td>
</tr>
<tr>
<td>Save As...</td>
<td>S</td>
<td>Save the current symbol to a different library.</td>
</tr>
<tr>
<td>Show Pin Electrical Types</td>
<td></td>
<td>Annotate pins with their electrical types</td>
</tr>
<tr>
<td>Show Symbol Tree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Synchronized Pins Edit Mode</td>
<td></td>
<td>Synchronized Pins Edit Mode When enabled propagates all changes (except pin numbers) to other units. Enabled by default for multiunit parts with interchangeable units.</td>
</tr>
<tr>
<td>Update Symbol Fields...</td>
<td></td>
<td>Update symbol to match changes made in parent symbol</td>
</tr>
<tr>
<td>Symbol Move Activate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Common

The actions below are available across KiCad, including in the Schematic Editor. Hotkeys can be assigned to any of these actions in the Hotkeys section of the preferences.

<table>
<thead>
<tr>
<th>Action</th>
<th>Default Hotkey</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude Marker</td>
<td></td>
<td>Mark current violation in Checker window as an exclusion</td>
</tr>
<tr>
<td>Next Marker</td>
<td></td>
<td>Go to next marker in Checker window</td>
</tr>
<tr>
<td>Previous Marker</td>
<td></td>
<td>Go to previous marker in Checker window</td>
</tr>
<tr>
<td>Action</td>
<td>Default Hotkey</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Add Library...</td>
<td></td>
<td>Add an existing library folder</td>
</tr>
<tr>
<td>Click</td>
<td>Return</td>
<td>Performs left mouse button click</td>
</tr>
<tr>
<td>Double-click</td>
<td>End</td>
<td>Performs left mouse button double-click</td>
</tr>
<tr>
<td>Cursor Down</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Cursor Down Fast</td>
<td>Ctrl + Down</td>
<td></td>
</tr>
<tr>
<td>Cursor Left</td>
<td>Left</td>
<td></td>
</tr>
<tr>
<td>Cursor Left Fast</td>
<td>Ctrl + Left</td>
<td></td>
</tr>
<tr>
<td>Cursor Right</td>
<td>Right</td>
<td></td>
</tr>
<tr>
<td>Cursor Right Fast</td>
<td>Ctrl + Right</td>
<td></td>
</tr>
<tr>
<td>Cursor Up</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Cursor Up Fast</td>
<td>Ctrl + Up</td>
<td></td>
</tr>
<tr>
<td>Switch to Fast Grid 1</td>
<td>Alt + 1</td>
<td></td>
</tr>
<tr>
<td>Switch to Fast Grid 2</td>
<td>Alt + 2</td>
<td></td>
</tr>
<tr>
<td>Switch to Next Grid</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Switch to Previous Grid</td>
<td>Shift + N</td>
<td></td>
</tr>
<tr>
<td>Grid Properties...</td>
<td></td>
<td>Set grid dimensions</td>
</tr>
<tr>
<td>Reset Grid Origin</td>
<td>Z</td>
<td></td>
</tr>
<tr>
<td>Grid Origin</td>
<td>S</td>
<td>Set the grid origin point</td>
</tr>
<tr>
<td>Inactive Layer View Mode</td>
<td></td>
<td>Toggle inactive layers between normal and dimmed</td>
</tr>
<tr>
<td>Inactive Layer View Mode (3-state)</td>
<td>H</td>
<td>Cycle inactive layers between normal, dimmed, and hidden</td>
</tr>
<tr>
<td>Inches</td>
<td></td>
<td>Use inches</td>
</tr>
<tr>
<td>Millimeters</td>
<td></td>
<td>Use millimeters</td>
</tr>
<tr>
<td>Mils</td>
<td></td>
<td>Use mils</td>
</tr>
<tr>
<td>Action</td>
<td>Default Hotkey</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pan Left</td>
<td>Shift + Left</td>
<td></td>
</tr>
<tr>
<td>Pan Right</td>
<td>Shift + Right</td>
<td></td>
</tr>
<tr>
<td>Pan Up</td>
<td>Shift + Up</td>
<td></td>
</tr>
<tr>
<td>Pin Library</td>
<td></td>
<td>Keep the library at the top of the list</td>
</tr>
<tr>
<td>Plot...</td>
<td></td>
<td>Plot</td>
</tr>
<tr>
<td>Print...</td>
<td>Ctrl + P</td>
<td>Print</td>
</tr>
<tr>
<td>Quit</td>
<td></td>
<td>Close the current editor</td>
</tr>
<tr>
<td>Reset Local Coordinates</td>
<td>Space</td>
<td></td>
</tr>
<tr>
<td>Revert</td>
<td></td>
<td>Throw away changes</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl + S</td>
<td>Save changes</td>
</tr>
<tr>
<td>Save All</td>
<td></td>
<td>Save all changes</td>
</tr>
<tr>
<td>Save As...</td>
<td>Ctrl + Shift + S</td>
<td>Save current document to another location</td>
</tr>
<tr>
<td>Save Copy As...</td>
<td></td>
<td>Save a copy of the current document to another location</td>
</tr>
<tr>
<td>3D Viewer</td>
<td>Alt + 3</td>
<td>Show 3D viewer window</td>
</tr>
<tr>
<td>Show Context Menu</td>
<td></td>
<td>Perform the right-mouse-button action</td>
</tr>
<tr>
<td>Footprint Library</td>
<td></td>
<td>Browse footprint libraries</td>
</tr>
<tr>
<td>Browser</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Footprint Editor</td>
<td></td>
<td>Create, delete and edit footprints</td>
</tr>
<tr>
<td>Symbol Library</td>
<td></td>
<td>Browse symbol libraries</td>
</tr>
<tr>
<td>Browser</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symbol Editor</td>
<td></td>
<td>Create, delete and edit symbols</td>
</tr>
<tr>
<td>Always Show Cursor</td>
<td>Ctrl + Shift + X</td>
<td>Display crosshairs even in selection tool</td>
</tr>
<tr>
<td>Full-Window Crosshairs</td>
<td></td>
<td>Switch display of full-window crosshairs</td>
</tr>
<tr>
<td>Show Grid</td>
<td></td>
<td>Display grid dots or lines in the edit window</td>
</tr>
<tr>
<td>Polar Coordinates</td>
<td></td>
<td>Switch between polar and cartesian coordinate systems</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td><strong>Default Hotkey</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Update Schematic from PCB...</td>
<td></td>
<td>Update schematic with changes made to PCB</td>
</tr>
<tr>
<td>Center</td>
<td>F4</td>
<td>Center</td>
</tr>
<tr>
<td>Zoom to Objects</td>
<td>Ctrl + Home</td>
<td>Zoom to Objects</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Home</td>
<td>Zoom to Fit</td>
</tr>
<tr>
<td>Zoom In at Cursor</td>
<td>F1</td>
<td>Zoom In at Cursor</td>
</tr>
<tr>
<td>Zoom In</td>
<td></td>
<td>Zoom In</td>
</tr>
<tr>
<td>Zoom Out at Cursor</td>
<td>F2</td>
<td>Zoom Out at Cursor</td>
</tr>
<tr>
<td>Zoom Out</td>
<td></td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Refresh</td>
<td>F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Ctrl + F5</td>
<td>Zoom to Selection</td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td>Cancel current tool</td>
</tr>
<tr>
<td>Change Edit Method</td>
<td>Ctrl + Space</td>
<td>Change edit method constraints</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl + C</td>
<td>Copy selected item(s) to clipboard</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl + X</td>
<td>Cut selected item(s) to clipboard</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
<td>Deletes selected item(s)</td>
</tr>
<tr>
<td>Interactive Delete Tool</td>
<td></td>
<td>Delete clicked items</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Ctrl + D</td>
<td>Duplicates the selected item(s)</td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl + F</td>
<td>Find text</td>
</tr>
<tr>
<td>Find and Replace</td>
<td>Ctrl + Alt + F</td>
<td>Find and replace text</td>
</tr>
<tr>
<td>Find Next</td>
<td>F3</td>
<td>Find next match</td>
</tr>
<tr>
<td>Find Next Marker</td>
<td>Shift + F3</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
<td>Paste item(s) from clipboard</td>
</tr>
<tr>
<td>Paste Special...</td>
<td></td>
<td>Paste item(s) from clipboard with options</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Redo last edit</td>
</tr>
<tr>
<td>Action</td>
<td>Default Hotkey</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td>Measure Tool</td>
<td>Ctrl + Shift + M</td>
<td>Interactively measure distance between points</td>
</tr>
<tr>
<td>Select item(s)</td>
<td></td>
<td>Select item(s)</td>
</tr>
<tr>
<td>Configure Paths...</td>
<td></td>
<td>Edit path configuration environment variables</td>
</tr>
<tr>
<td>Donate</td>
<td></td>
<td>Open &quot;Donate to KiCad&quot; in a web browser</td>
</tr>
<tr>
<td>Get Involved</td>
<td></td>
<td>Open &quot;Contribute to KiCad&quot; in a web browser</td>
</tr>
<tr>
<td>Getting Started with KiCad</td>
<td></td>
<td>Open “Getting Started in KiCad” guide for beginners</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td>Open product documentation in a web browser</td>
</tr>
<tr>
<td>List Hotkeys...</td>
<td>Ctrl + F1</td>
<td>Displays current hotkeys table and corresponding commands</td>
</tr>
<tr>
<td>Preferences...</td>
<td>Ctrl + ,</td>
<td>Show preferences for all open tools</td>
</tr>
<tr>
<td>Report Bug</td>
<td></td>
<td>Report a problem with KiCad</td>
</tr>
<tr>
<td>Manage Footprint Libraries...</td>
<td></td>
<td>Edit the global and project footprint library lists</td>
</tr>
<tr>
<td>Manage Symbol Libraries...</td>
<td></td>
<td>Edit the global and project symbol library lists</td>
</tr>
</tbody>
</table>